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Welcome From The Chief Editor
We hope you’ve enjoyed our coverage of the
Gnome 2.32 desktop environment. Even though
Gnome 3.x has supplanted 2.32 as the default
offering for Gnome, I doubt that Gnome 2.32 will be
going away anytime soon. Gnome 2.32 still has
many, many followers and devotees.
Over seven months, starting in November 2011 and
ending in May 2011, we ran three Gnome 2.32
articles a month (four in May 2011), for a grand total
of 22 articles. That’s more coverage than we’ve
done for any other desktop environment in our
desktop coverage in The PCLinuxOS Magazine.
During the time (a full two years) that we’ve been
running
articles
on
the
various
desktop
environments, I’ve learned a few things. First, I came
to appreciate some of these desktop environments.
Had I not started work on covering these desktops, I
doubt that I would have even considered using some
of them. Remarkably, some of those are the ones I
like best. Secondly, I discovered how passionate
Linux users are about their favorite desktop
environment. I also discovered that I am not immune
to similar passionate feelings about my favorite
desktop. I am a selfconfessed Xfce lover. For me, it
provides the perfect desktop environment. It doesn’t
go overboard with flash and glitz, it stays out of my
way and lets me work the way I want to, and it’s a
fast and mature desktop.
To me, Gnome 2.32 fit me pretty well. It had a
familiar “feel” with the top and bottom panel. It
actually felt like Xfce with more whistles and bells. In
all honesty though, I found the obscurity of settings
in Gnome a bit unsettling. I’m still trying to find out
why the Gnome developers feel that it is necessary
to hide a lot of configuration settings from most
users, except the Gnome power users who know
where to find them. All reports on Gnome 3.x is that
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the Gnome developers have taken this concept to
new heights, much to the chagrin of many users.
Maybe I’ve been spoiled by Xfce and KDE, where
most of the settings are easily accessible and “in
your face.”
Nonetheless, Gnome 2.32 is a rich and robust
desktop. We’ve collected all 22 Gnome 2.32 articles
here, in one PDFonly special edition of The
PCLinuxOS Magazine, so that you may use this
compendium of Gnome 2.32 information as a
resource. Gnome 2.32 is not dead – at least, not yet,
anyways. It remains to be seen how the Mate
desktop, the fork of Gnome 2.32, will fare with users.
Early reports are encouraging!

Disclaimer
1.

All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2.

The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3.

The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4.

No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5.

Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.
Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or oral,
regarding such subject matter.
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Gnome 2.32: An Overview
by Paul Arnote (parnote)
The Linux world has been all abuzz about the new
Gnome 3.x desktop environment. Some like it.
Many, including Linus Torvalds, hate it. Just as KDE
went through a metamorphosis (with much
consternation) a couple of years ago when the move
from KDE 3.5.x to KDE 4.x took place, it’s now time
for Gnome users to experience similar growing
pains.
Those Gnome users who hate the new version have
few choices. First, they can opt to change desktop
environments. As a result, the Xfce desktop is
seeing many Gnome refugees, including Linus
Torvalds. Some Gnome users are giving a more
mature KDE 4 another shot.
As a second choice, many are opting to stay with
Gnome 2.32 as long as possible. The third choice is
to support the effort to fork Gnome 2.x, thus keeping
it alive much longer. Such a fork has already taken
root, with the Mate Desktop Environment project.
Even Linus Torvalds, calling Gnome 3.x an “unholy
mess,” called out to his Fedora/Red Hat friends,
urging them to consider forking Gnome 2.x.
Although unofficial, the BlueBubble project is yet
another attempt to fork Gnome 2.x by a Fedora
Ambassador. It’s too early to tell if Mate or
BlueBubble will have any more success than the
Trinity project, designed to keep KDE 3.5.x alive.
Wait … what? Starting off a Gnome 2.32 overview
article talking about Gnome 3.x? Yep. Here’s the
deal. Much as was the case when KDE 3.5 gave
way to KDE 4, Gnome 3.x is coming, like it or hate it
… and the “hate it” camp is rapidly filling up. Texstar
and the rest of the PCLinuxOS development team
are currently working to bring the Gnome 3.x
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desktop to PCLinuxOS users. Members of the
PCLinuxOS Testing mailing list have been able to
run a testing version of Gnome 3.x. So why start off
a talk about Gnome 2.32 by talking about Gnome
3.x? Well, there is a “fallback” mode in Gnome 3.x,
allowing it to function much as Gnome 2.32. In order
to understand and use that “fallback” mode
adequately and efficiently, we need to cover Gnome
2.32.
Zen Mini 2011.07
To get a good handle on Gnome 2.32, the magazine
staff is using the last Zen Mini Live CD that siamer
made before resigning from the project, due to
changing demands and responsibilities in his life.
From the description about Zen Mini, on the Zen
Mini home page:
ZENmini (often shortened to ZEN) is a minimal Live CD
that is bootable and can be installed. It comes with a very
basic GNOME desktop without additional applications. It
is designed for advanced users or for users who wish to
learn how to customize their system with the applications
and support files they want to use. Additional software
can be installed through the Synaptic Software Manager
(requires network connection). Add your own
background, window decorations, web browser client,
email client, music client and fully trick out your desktop
the way you want it. ZEN is based on PCLinuxOS!
Upon launching the Zen Mini 2011.07 Live CD, you
will be greeted with a screen like that depicted at the
top of the next column.
Upon first glance, you may be taken aback by its
very nonGnomelike appearance. In fact, the screen
in the default Zen Mini installation could easily be

mistaken for an LXDE desktop. Or a KDE desktop.
Or most any other Linux desktop. When most users
look at a Gnome desktop, they expect to see the
panels at the top and bottom of the screen, with the
usual Gnome Applications, Places and System
menus at the upper left corner of the top panel. After
all, it’s the “standard” appearance of the Gnome
desktop that we’ve become accustomed to seeing.
In fact, it’s how many of us immediately recognize
the Gnome desktop.
Siamer broke with Gnome tradition in Zen Mini,
opting instead to go with a single panel at the bottom
of the screen. As a result, he has produced a very
clean looking, yet functional, Gnome desktop.
If you want a “more traditional” Gnomelike
appearance to your Zen Mini desktop, it’s easy
enough to recreate the typical Gnome appearance,
with panels at the top and bottom of your screen,
along with the usual Gnome Applications, Places
and System menus at the left side of the top panel.
This is what I have done on my Zen Mini installation.
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To do this, I moved the bottom panel to the top, then
recreated a second panel at the bottom. I also
inserted the typical Gnome menus on the left side of
the top panel. In the process, I changed to a
wallpaper created by PCLinuxOS Gnome/Zen Mini
user Dragynn, as well as adding in some additional
panel plugins that I typically find useful.

surrounding Gnome 2.32. Just as we’ve done
through articles on KDE 4, Xfce, LXDE, e17 and
Openbox, we hope to give you greater insight into
the Gnome desktop, and some of the things that you
can do with it. Plus, with the “fallback” mode in
Gnome 3.x, understanding Gnome 2.32 takes on
even more importance.
For the magazine staff, we picked the 2011.07 Zen
Mini release from siamer. We believe that it is a
more balanced version than the 2011.09 release
from Melodie. Siamer had a better blend of included
applications and multimedia codecs. It was as
though he understood what a Gnome user was
looking for when seeking out a miniature version of
Gnome. Melodie’s 2011.09 release strips out those
codecs and adds in applications that are either
redundant or unnecessary in a mini release. With a
mini release, which is usually aimed at a more
advanced user, any extra applications can be added
as the user wishes right from Synaptic.

I have Zen Mini 2011.07 physically installed on my
test machine. This computer, an IBM Thinkpad T23,
has a 1.13 GHz Intel Pentium III Coppermine
processor, 512 MB RAM, 8 MB video RAM,
DVDRW/CDRW, and a 1024 x 768 LCD display.
Despite the relatively old status and slower
processor on this computer, Zen Mini 2011.07 flies
on this T23. Certainly, it doesn’t run as fast as the
lighter weight desktops (such as Xfce, LXDE or
Openbox), due to the overhead of all the Gnome
dependencies, but the performance is quite
adequate and sufficient. The only slowdowns that I
have experienced is when the modest 512 MB of
RAM becomes filled, and items are moved to the
swap partition of the hard drive.
Plans & Conclusion
We hope, through our articles about Gnome 2.32,
we can help unravel some of the mystery
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Undoubtedly, there will be many PCLinuxOS Gnome
users who balk at using Gnome 3.x. It has been the
same pattern of complaints with every distro that has
released a version of Gnome 3.x. Gnome 2.x made
many settings obscure to all but advanced users.
Yet with Gnome 3.x, the Gnome developers have
taken obscurity to a whole new level. According to
Linus Torvalds, perhaps they have gone too far.
When discussing Gnome 3.x, Torvalds has been
quoted as saying, “This 'users are idiots, and are
confused by functionality' mentality of Gnome is a
disease. If you think your users are idiots, only idiots
will use it."
You definitely owe it to yourself to give Zen Mini a
try. It’s fast, responsive and has a “just right” blend
of applications to get work done. Sure, you may
have to install a few applications from Synaptic, but

siamer has anticipated the needs of an average user
in his 2011.07 release so well that you will find
yourself installing a minimum number of extra
applications. Most users installing a mini ISO of any
desktop enter the equation with a core list of
applications that they normally use. With Zen Mini,
you get a very stable core of basic applications upon
which to install your list of mostused applications.

Does your computer run slow?
Are you tired of all the "Blue Screens
of Death" computer crashes?
Are viruses,
adware, malware &
spyware slowing
you down?
Get your PC back
to good health
TODAY!
Get

Download your copy today! FREE!
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Gnome 2.32 Control Center, Part 1
by Meemaw
The first thing many people do when they finish
installing their new Live CD is configure their
desktop, if they didn’t already do it while running it
while running the Live CD. The place to do that in
Gnome is in the menu at System > Control Center.

Clicking on this menu item will open the Control
Center. The Control Center is arranged in five
different sections, which are listed in the lefthand
column. In this article we will cover the first two
sections, Personal and Internet & Network.
Personal is the largest section. It has twelve
sections, all dealing with configurations for your
desktop. The first section, About Me, allows you to
add in your personal information, if you want it to be
saved on your computer. You can change your
picture and password from here, as well as adding
your email address(es), IM nicks, home address and
even work information and your web pages.
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The next section, Appearance, is where most of the
desktop configuration can be done. This section
works a little differently than it does in some of the
other desktops. The first window presents you with
theme, background (wallpaper) and fonts tabs. To
find the additional items you may want to change
(such as your mouse pointers), you should choose
the theme you want to use, then click ‘Customize.’
You will see another window with five tabs:
Controls, Colors, Window Border, Icons and
Pointer. Controls is the configuration for buttons
and check boxes. In Colors, you can change your
window background color, highlight color, or default
font color. Window Border lets you configure the
shape of your title bar and border thickness. Icons is
where you choose the icon set you wish to use from
the ones you have installed, and Pointer is where
you select your desired mouse pointer. It even has a
slide bar so you can make your pointer bigger.
This configuration window works well, because if you
like one theme’s colors and another theme’s window

borders, you can ‘mix & match’ until you get what
you like. Changes that are made take effect
immediately, so if you choose something you don’t
like, you are free to change it back immediately.
The next section is Assistive Technologies, which
allow you to program special ways for computer
access. When you click File Manager, you will get
the Preferences window in the Nautilus file manager.
Keyboard Shortcuts lets you designate hotkeys for
specific functions. Clicking Main Menu gives you a
window where you can edit your menu. Be careful
that you don’t delete something you need!!!
The next item is Power Management. From here
you can configure the time frame for standby or
sleep modes. Preferred Applications is next where
you can decide the default program that opens when
you click on a sound or video file, web link or
terminal icon. You can also choose your default
news reader. Screensaver lets you configure your
screensaver, and Startup Applications lets you
designate the programs, such as conky or Dropbox
so that they start when your desktop starts.
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Windows is actually Window Preferences, and you
can choose other preferred actions for your windows
(one being the action you want if you doubleclick a
window’s title bar). Finally, ZENmini Live USB
Creator is located right here so you can make a
backup copy of your install, just in case of a
problem.
The second section, Internet and Network,
contains a single item; Network Proxy. Most of us
will choose direct connection, but many companies
use a proxy, and would choose to configure it
manually.

Connect

All your
PCLinuxOS
connections in one
convenient location!

Screenshot
Screenshot Showcase
Showcase

In Part 2 we will cover the rest of the Gnome Control
Center.

A magazine just isn't a magazine
without articles to fill the pages.
If you have article ideas, or if you
would like to contribute articles to the
PCLinuxOS Magazine,
send an email to:
pclinuxos.mag@gmail.com
We are interested in general articles
about Linux, and (of course), articles
specific to PCLinuxOS.
PCLinuxOS Magazine

Posted by Dragynn.
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Gnome 2.32: PCLinuxOS Tweak
by Darrel Johnston (djohnston)
PCLinuxOS Tweak is a custom package written for
PCLinuxOS. It allows the user to set some "hidden"
options within the Gnome desktop. Install the
pclinuxostweak package from Synaptic, then start
the application by selecting System > Administration
from the PCLinuxOS Gnome menu. You will be
greeted with the Welcome screen.

been reported before. Note that the plans are to
drop this package from the repository, as the
settings will no longer apply in Gnome version 3.
Clicking on the Autostart button in the left panel
shows a list of programs that are started when you
login. You can enable or disable each one by

no extra programs displayed when I check the Show
all runnable programs box.

checking or unchecking the item.re are two options
below the right panel. Show comments will enable a
brief description for what each program does. I see

icons to show on the desktop. The last item is to
show the contents of your home folder on the
desktop.

Click the Computer button in the left panel to see
system and user information displayed in the right
panel. Although it may appear so, none of the
information shown can be edited, even as user root.
Both information lists are very basic (image top of
next column).
Clicking on the Startup button in the left panel
unhides two subsections, Session Control and
Autostart. Session Control is selected automatically,
and brings up an error window. Clicking on the Error
message dropdown arrow shows us the error
messages. Three python scripts are involved in the
errors, /usr/share/pclinuxostweak/mainwindow.py,
/usr/share/pclinuxostweak/session.py,
and
/usr/lib/python2.6/posixpath.py. This problem has
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Clicking Desktop, the next button down in the left
panel, brings up three subsections. The first
subsection, Icons, has the desktop icons settings.
Except for the last settings, all options are for what
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panel is an option to enable Metacity's window
compositor. Clicking on that option will bring up a
message window stating that visual effects in
"Appearance" should be disabled.

The next Desktop subsection is Windows. The first
section in the right panel is Window Decorate Effect.
We can choose to use the Metacity window
manager's theme instead of Gnome's. We can also

choose to enable active and inactive window
transparency, and set the level of transparency for
each. The second section in the right panel is
Window Titlebar Action. All actions are based on the
mouse wheel or mouse clicks. The mouse wheel has
only two options, none or roll up. Each of the mouse
clicks have six options: none, maximize, minimize,
roll up, lower or menu. The third section in the right
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The third Desktop subsection is GNOME. Under
Panel and Menu, we have three panel options and
two input method options for the context menu. Next
is a Screensaver section, followed by a History
section, each with one option.

The next major button in the left panel is Personal.Cli
cking it reveals four subsections. In the first one,
Folders, we can set the default paths for folders
commonly used by programs (image top of next
column).
The next subsection button is Templates. Here, we
can manage document templates by simply
dragging them from one window pane to another.
The active templates will be the ones shown in the

desktop and folder rightclick context menu under
Create Document.
The next subsection button is Scripts. Many of these
are file manager shortcuts, such as Copy to or Link
to. Some call external programs, such as Convert
image to PNG.
The last subsection button under the Personal
button is Shortcuts. This section is for defining
keybindings. Doubleclick one to input a new key
combination and the command to be associated with
it.
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Clicking the last major button, System, also reveals
four subsection buttons. File Type Manager allows
you to select what application program will open a
particular filetype. Doubleclick one of the filetypes to
make the program selection. Unchecking Only show
filetypes with an associated application will show all
system filetypes (first image, top of next column).

The third subsection button, Power Management,
will allow you to set a few advanced power
management options (first image, next page).

Clicking the next subsection button, Nautilus, will
allow you to set a few Nautilus file manager options
(second image, next column).

PCLinuxOS Tweak gives you quick access to many
Gnome desktop features, as well as a few not
available in Gnome's desktop preferences. Note that
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all the selections shown above are system defaults
after a fresh installation with a few new packages
installed.

The last subsection button and last button in the left
panel, Security, allows you to set some of the
system security options.
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Gnome 2.32 Control Center, Part 2
by Meemaw
In the first part of this article we looked at the first
two sections of the Gnome Control Center, Personal
and Internet & Network. In this part we will look at
the remaining three sections of the Control Center:
Hardware, System and Other.

the computer. Check the Lock screen to enforce
typing break option to enable the other options.
Work Interval lasts is how many minutes to use the
computer. Break interval lasts sets the number of
minutes for the timeout. Check the Allow postponing
of breaks option to optionally override the typing
break options when the work interval has expired.

Hardware

Monitors

Hardware has five sections:

Allows you to set your screen size, monitor refresh
rate, and screen rotation to either landscape or

Keyboard
When you open this, you get 5
tabs.
General sets your preferences for
actions to be taken if a key is held
down, and how fast the cursor
blinks.
Layout lets you add another
keyboard layout (default is
whatever you picked during
install) and set options for your
layout.
Accessibility sets options for
‘sticky’ keys, ‘slow’ keys and
‘bounce’ keys.
Mouse Keys lets you set your
desired keys to use use the
keyboard to move the cursor, if
you wish.
Typing Break lets you set a timer
to enforce a “timeout” from using
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portrait mode. There is also a Detect monitors button
for multiple monitors.
Mouse
Two tabs are in this section. General lets you
configure pointer speed, click speed, drag & drop
and designate if you need a left or righthand
mouse. Accessibility allows for some extra options
for easier mouse operations.
Power Management
This is where you set your
options for hibernate and sleep
modes.
Sound Preferences
This section has five tabs;
Sound Effects  Here you can
set not only the volume level for
your default sounds, you can set
a sound theme and a different
volume level for alerts.
Hardware will let you configure
your hardware, if needed.
Input lets you choose the
hardware you want to use, plus
other input settings.
Output lets you choose the
hardware you want to use, plus
other output settings.
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Apps lets you configure settings in different audio
programs. The program has to be running.
System
The sections here match the sections in PCLinuxOS
Control Center. Authorizations (designates whether
a user can perform a certain action or if only root
can do it), Firewall Setup (configures a firewall),
GDM Login Setup (everything from the login theme
to enabling remote login), GParted (partitioning your
drive), Network Center (configuring you Internet
connection), NTFS Configuration (configure
Windows compatibility) and Update Package
Sources List.
Other
Configuration Editor is an editor for the GConf
Configuration System.
Configure Your Computer This is another link to
the PCLinuxOS Control Center.
Gnome PPP is for the configuration of dialup
connections
Privilege Granting asks you to designate whether
you use ‘su’ or ‘sudo,’ and will let you designate
whether screen grabbing is allowed during root
password entry, which means that your running
programs are paused any time you are asked to give
your root password.

Want to keep up on the latest that's
going on with PCLinuxOS?
Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos

Reach Us On The Web
PCLinuxOS Magazine Mailing List:
http://groups.google.com/group/pclinuxosmagazine

Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!

PCLinuxOS Magazine Web Site:
http://pclosmag.com/
PCLinuxOS Magazine Forums:
http://www.pclinuxos.com/forum/index.php?board=34.0

Regional Settings lets you change your language
settings.
Questions about Gnome programs can always be
answered on the Gnome forum.

PCLinuxOS Magazine
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Gnome 2.32: gLabels Label Designer
by Meemaw
One program available in Gnome is gLabels. It is a
very simple program that can do any kind of label or
business card. While written for the Gnome desktop
environment, gLabels will also run quite nicely on
any other graphical Linux desktop environment. Like
many Linux applications released under the GPL, it
does one thing, and does it well. Unless you have
Gnome 3, the version you are likely to see in the
repo is version 2.3.0.
When you first open gLabels you get the following
screen:

Notice that the only tools that are active are the
‘New’ and ‘Open’ buttons. When you click on ‘New,’
you will get a screen that asks which label type you
wish to use.
You can search for the one you want in the ‘Search
All’ tab, or you can design your own in the ‘Custom’
tab. Any label you use will be saved in the ‘Recent’
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tab, so it will be easy to find later. I chose the Avery
5160 address label because that’s what I use the
most. You will also get a screen asking if you want
your chosen label oriented horizontally or vertically,
and another window giving you a page preview of
the sheet you have chosen. After clicking on the OK
button to verify your choices, the window at right top
is visible.

window will open and allow you to enter your text
(the first tab in the section on the right is the text
tab), then use the other tabs to format your text as
desired. In addition, the toolbar across the bottom
also includes text formatting items. You can always
increase the size of your text frame by grabbing one
of the corners and dragging and move it by hovering

Notice that now all the tools are active. We have in
the top toolbar: New, Open, Save, Print, Cut Copy
and Paste. In the second line of tools you will see:
Selection tool, Text tool, Add Rectasngle, Add Line,
Add Circle, Add Image and Add Barcode. The four
buttons to the right of that are the sizing buttons,
where you can increase or decrease the size of your
label in the window (zoom in, zoom out, actual size
and fit in window). The last button in that row is the
Mail Merge Properties button.
If you click the Add Text button, your pointer will
change to a plus sign with the word Text next to it,
and you can click on the label to place the text
frame. Wherever you click will place the top left
corner of the text frame. At right, the text formatting
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over the text until the cursor turns into a 4arrowed
cross, then clicking and dragging. In the other tabs,
you can set the style and size of the text and the
position of the text frame. At the bottom, you can
change the alignment of your text.
One thing that is in gLabels that I haven’t seen in
other programs is a specific tab just for text shadow.
You have to enable the shadow, and then choose
the offset color and opacity of the shadow. I made
the shadow green so you could see it.

Using the toolbar at the top, you can also insert a
rectangle, line, circle or picture into your label. Each
item you choose opens a set of tabs at the right side
of the window with your configuration choices. In the
screenshot below, I added a blue rectangle and
inserted a photo of a green Christmas decoration on
top of it. The rectangle is selected and can be
edited.
Don’t forget to save your label design in a
convenient place.
Printing is easy, as well. Clicking the print icon gives
you a window that lets you designate your printer,
verify your page setup (paper size, type, printer tray
to use, orientation, etc.), and choose how many
labels you want printed. The third tab, ‘Labels,’
shows you a preview of your page, and lets you print
a certain number of labels on a page, or a certain
number of full pages. I have printed 15 of one label

on the sheet with missing labels) on the sheet with
the missing labels. It sure beats having to throw
away a sheet of labels just because some labels are
missing. Just select the radio button next to “Labels”
under “Copies.” Then, adjust the label number you
want to start printing from, to skip the missing labels.
Label 1 is in the upper left corner, label 3 is in the
upper right corner, label 28 is in the lower left corner,
and label 30 is in the lower right corner.
While it’s nice to print a sheet of return address
labels, we usually want to print a group of mailing
labels with different names and addresses using a
mail merge list. Merging a mailing list in gLabels is
actually fairly easy. Many people use LibreOffice to
do spreadsheets and labels. While I use LibreOffice
for labels most of the time, I recently had gLabels
open because I had some address labels designed
in it. So, I decided to use it for the mailing labels for
my Christmas cards. Click that last icon in the top
toolbar, Edit Merge Properties.

on the top of one page, then turned the page upside
down and printed 15 of another label on the
remainder using a 30label sheet like this.
This latter feature is handy if you have a sheet of
labels that have some labels missing. You can start
printing from the first available label, and print out as
many labels as you like (or use the rest of the labels
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Assuming you have your mailing list in a
spreadsheet, the first thing you need to do to use it
in gLabels is to open it in the spreadsheet program
you use, then save your spreadsheet as a comma or
tabseparated text file. In LibreOffice, I saved mine
as MeemawsList.csv. You can also use your
Evolution addressbook or Vcards if you use those
programs.
Select the type of file you are using and then
designate the location of that file. You can even
choose which records you want to include in your
merge by checking or unchecking the ‘Select’
column in the merge properties box. (I don’t send
Christmas cards to my whole address book.) Put in
your text frame, then click ‘Insert merge field’ at the
bottom of the text frame properties window. Choose
your fields, and arrange them in your label the way
you want them. Save your file.

Having used more than one word processing
program for labels, I will say that I found gLabels to
actually be easier. I once had a glitch during a larger
printing. My newsletter mailing at work was almost
1,300 labels. During the printing, I found that one
sheet of labels had fed through the printer
improperly, and all the addresses on that sheet
printed over 2 labels, rather than each one on its
own. I went back into the merge properties window,
selected only those addresses that misprinted, and
printed a new sheet. Perfect!
You don’t have to use it for just address labels!
Some of the pages made today are also business
cards, name badges, file folder labels, disk and tape
labels, CD case plates and even table tent cards.
You can also create custom designs on one of the
many full sheet labels or plain paper. Let your
imagination be your guide!

You can now go to Print. When you click on the
Labels tab you will see a merged sheet. If you click
on Print Preview at the bottom of that window,
gLabels will display the merged labels as a PDF
document in whatever reader you are using. The
Print Preview might take a minute or two, if your list
is long (top of next column).
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Gnome 2.32: Sail Through Your Files With Nautilus
by Paul Arnote (parnote)
It’s quite fitting that it’s named after the infamous
ship in Jules Verne’s 20,000 Leagues Under The
Sea. The Gnome native file manager, Nautilus, is a
powerful tool for navigating and working with the
files on your Gnome installation.

Looking at the screen shot, it’s hard to distinguish
Nautilus from any other capable Linux file manager.
It looks a lot like KDE’s Dolphin, Xfce’s Thunar, or
LXDE’s PCManFM. Plus, in a lot of ways, it also
functions similarly to all of its desktop brothers.
At the top left section of the Nautilus window, you
have access to your home partition, the file system,
any extra partitions or drives (such as USB flash

drive, USB extermal hard drives, or optical disks),
and any network drives.
At the bottom left section of the Nautilus window,
you have quick, oneclick access to frequently used
folders. To add additional folders to the quick access
area of Nautilus, just drag the folder icon from the
right window pane into its new location in the lower
left corner of the Nautilus window.
The right section – literally the rightmost ¾ of the
Nautilus window – is dedicated to showing your files
and subdirectories.
There are quite a few “hacks” for Nautilus running
around out there, but “hacks” might not be the best
term here. More than anything, there are quite a few
hidden or notso obvious settings you can adjust that
will make it more useful, and that will customize how
it displays file data.
One such place is Tech DriveIn, with their “8 Not
SoCommon Nautilus Hacks & Improvements”
article. They also have another article that reveals a
Nautilus script that will send documents to Google
Docs. Just do an Internet search, and you will be
flooded with results. Just don’t be surprised when
you see an overabundance of Ubuntu related
results, given that Gnome is the main desktop
environment of Ubuntu. Ubunturelated or not, you
will still find much of the information just as pertinent
to Gnome running on PCLinuxOS.
Beyond
Aesthetics:
Functionality

Extending

Nautilus’s

Just as with KDE’s Dolphin and Xfce’s Thunar
(sorry, but PCManFM doesn’t yet have this ability),
you can extend the functionality of Nautilus’s right
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click context menu. The tasks you can perform this
way are truly only limited by your imagination, and
can make file management tasks go from being a
chore to being super simple and fast.
It’s very easy to extend Nautilus’s functionality.
Basically, anything you can imagine using a bash
script for can also be used with Nautilus. That’s
because Nautilus uses bash scripts as the basis for
its extensions.
To facilitate the use of bash scripts, Nautilus will set
some special parameters (known as environment
variables) to the bash script that’s being called.
These environment variables help making bash
scripts to extend Nautilus’s functionality even easier
to create and work with. They are listed below.
NAUTILUS_SCRIPT_SELECTED_FILE_PATHS:
newlinedelimited paths for selected files (only if
local)
NAUTILUS_SCRIPT_SELECTED_URIS:
delimited URIs for selected files
NAUTILUS_SCRIPT_CURRENT_URI:
location

newline
current

NAUTILUS_SCRIPT_WINDOW_GEOMETRY:
position and size of current window
So, you can use traditional ways of enumerating file
names or data sent to a bash script, or you can
make use of the environment variables set by
Nautilus. The choice is entirely up to you, as either
will work perfectly fine.
Probably the best way to customize Nautilus’s
context menu is to find premade Nautilus scripts.
There are plenty of them out there on the ‘net for
you to choose from. Below, I’ve listed just a few of
the sites that I’ve found.

there, to learn more about creating your own
Nautilus scripts.
My Nautilus Scripts: a collection of useful Nautilus
scripts. The scripts are available as *.deb files (for
Ubuntu and Debian), or as *.tar.gz archives.
PCLinuxOS users will need to download the latter.
125 Nautilus Scripts To Simplify Nautilus: This is
a collection of 125 Nautilus scripts, available in a
*.tar.gz file. While some are overly simplistic, there
are quite a few in the collection that should be useful
to you.
Once you have your scripts in hand, you need to
place them in the the hidden .gnome2 directory, in
your home directory (/home/username/.gnome2),
under the /nautilusscripts subdirectory. Just the
mere presence of the script in the appropriate folder
is not sufficient. You will need to restart Nautilus for
the script to be recognized.
Also, all of the directions say to make the script
executable (easily done via the file properties
“Permissions” tab). However, I’ve not done this to
any of the scripts I’ve placed there, and they all
seem to work just fine without the file being marked
as executable. I don’t know if this is a weird anomaly
on my system, so if your script isn’t working, you
might want to check to make sure that it’s marked as
executable.

After you restart Nautilus, then your script will then
appear in the Scripts context menu, as shown in the
screen shot above.
These three aforementioned sites should give you a
good start on finding premade Nautilus scripts. If
you want to find more, just do an Internet search,
using “nautilus scripts” as your search term.
Roll Your Own
If you feel so inclined, you can edit and further
customize the premade Nautilus scripts to perform
tasks that give you even more functionality. You can
even write your own script from scratch, if you find
that more to your liking. Personally, I find it
advantageous to alter the premade Nautilus scripts
to do what I want them to.
Having worked on The PCLinuxOS Magazine for as
long as I have, there are a few things that I like to do
that help me streamline the production of the
magazine. Some of those tasks involve resizing
images and placing a one pixel black border around
images. Rather than open up an image editing
application such as Gimp or MTPaint to perform
those simple tasks, it’s much easier to be able to
perform these tasks from a special context menu
item right from the file manager.
Because my requirements for these tasks are rather
precise, I usually have to “roll my own” special
functions to get them accomplished from a file
manager context menu. So, I looked and found a
Nautilus script that used ImageMagick’s “convert”
command. The script I found converted any image
into a *.jpg file. I then changed the script so that it
resized the selected images and placed a one pixel
border around the image, all in one step.

GScript: this site is dedicated to Nautilus scripts,
and has several freebie scripts, separated into
categories. You might also want to visit the FAQ
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Here is the script, in its original form:
#!/bin/bash
while [ $# gt 0 ]; do
picture=$1
jpg_file=`echo "$picture" | sed
's/\.\w*$/.jpg/'`
/usr/bin/convert quality 75 "$picture"
jpeg:"$jpg_file"
shift
done

Here is the script after I modified it:
#!/bin/bash

while [ $# gt 0 ]; do
picture=$1
convert resize 598 bordercolor Black border 1x1
"$picture" "600$picture"
shift
done

Since I’m not interested in changing the file to a *.jpg
file, I completely eliminated the line that starts with
“jpg_file.” Next, I altered the “convert” line to resize
the image to 598 pixels, then place a one pixel black
border around the entire image, resulting in an
image that’s resized to 600 pixels wide, and
renamed with 600 appended to the beginning of the
resized image file name – all in one quick and easy
step.
I saved the file to the /home/username/.gnome2/
nautilusscripts directory as Resize600Border. Upon
restarting Nautilus, my new script is displayed by its
name in the Scripts context menu. So, right clicking
on an image file, I can select the script from the
Scripts menu, and the image will immediately be
resized to 600 pixels wide, with a one pixel black
border surrounding it.

PCLinuxOS Magazine

Summary
Nautilus is a very capable file manager, and one that
is very easily extended with Nautilus scripts. If you
are installing Nautilus on a desktop other than
Gnome, be forewarned that it pulls in a literal TON of
Gnome dependencies.
If you are a Gnome or Nautilus user, you owe it to
yourself to explore the possibilities that are available
to you, via Nautilus scripts. There are premade
Nautilus scripts to perform all kinds of actions – from
audio and video file conversion, to managing archive
files, to sending files via email, to just about anything
else that you might be able to imagine. You don’t
have to be a scripting guru to make good use of
Nautilus scripts. Yet, if you are a script guru, there’s
virtually no end to what you might be able to
accomplish.

It's easier than E=mc2
It's elemental
It's light years ahead
It's a wise choice
It's Radically Simple
It's ...
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Gnome 2.32: Metacity Window Manager
by Darrel Johnston (djohnston)
Metacity is a lightweight window manager written by
Havoc Pennington from Red Hat. The first version
was 2.3, which was released in 2001. It is
implemented with the GTK+ 2.x toolkit, and so
integrates well with the GNOME 2.x platform. In fact,
the intention is to remove the traditional separation
between window manager and desktop, and present
to the user a single desktop interface. Before the
introduction of Metacity in GNOME 2.2, GNOME
used Enlightenment (e16) and then Sawfish as its
window manager.
Metacity was the window manager used by default
in the GNOME desktop environment until GNOME 3,
where it was replaced by Mutter.
From the Gnome 2.2 Release Notes:
"GNOME 2.2 officially incorporates the Metacity window
manager, a fully integrated window manager that uses
GTK+ for UI elements, communicates tightly with the
panel and other desktop elements, and is configured
straight from the GNOME preferences dialogs.
At the same time, all interaction between the window
manager and the desktop is done via documented
standards (see Section 6 ― Standards Compliance), so
you can substitute the window manager of your choice
from a long list of available options: Sawfish, fvwm2,
icewm, Waimea, Openbox, are just some of them."
Metacity window manager is the default in
PCLinuxOS Zen Mini edition. In the window below, I
used wmctrl to show the window manager in use.
To configure the Metacity settings, you can open a
terminal and enter gconfeditor. The Gnome
Configuration Editor window will then appear. You
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The general category gives us access to the
compositing manager option as well as a few other
audio and visual options.

can get the same results by launching the
Configuration Editor from the menu, System >
Preferences > Configuration Editor. Once launched,
open the apps folder in the left pane, then scroll
down and open the metacity folder to see the
configuration categories.
To change the values in any entry, doubleclick the
entry in the right pane and a preferences dialog
window will appear for that entry. The choices will be
different for each entry, depending on whether the
values are boolean, integer or a string value. In the
window below, we see a string value entered for
workspace 1 under workspace_names options.
Although “Desktop 1” is the new value entered, it
could be any descriptor.
To see a few more options, and to more easily
configure Metacity, we can install the package
pclinuxostweak. After installing the package, we
can launch it by going to the menu, System >
Administration > PCLinuxOS Tweak. Then navigate
in the left pane to Desktop > Windows. In the
window shown below, I have just clicked the Enable
Metacity’s Compositing feature box. A dialog window
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immediately appears with the message “To enable
the compositing feature of metacity, you should
manually disable Visual Effects in “Appearance”.

enable or disable compositing and set window
titlebar actions with just a few mouse clicks.

Want To Help?

The dialog window is referring to a tab which no
longer appears in the Gnome Appearance
Preferences settings unless compiz is enabled.
(From the menu, System > Preferences >
Appearance).
Using the PCLinuxOS Tweak tool, we can set
transparency levels for active and inactive windows,
enable or disable use of a Metacity window theme,

PCLinuxOS Magazine

And, going back to Gnome’s Configuration Editor,
there are five options for the PCLinuxOS Tweak tool
listed there.
The addition of the pclinuxostweak package gives
us a few more Metacity configuration options we
don’t have in Gnome’s Configuration Editor.

Would you like to help with the PCLinuxOS
Magazine? Opportunities abound. So get
involved!
You can write articles, help edit articles, serve
as a "technical advisor" to insure articles are
correct, create artwork, or help with the
magazine's layout.
Join us on our Google Group mailing list.
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Gnome Schedule Puts Gnome On A Schedule

by Paul Arnote (parnote)
There are times when you may want to run an
application while you are away from the computer.
The things you may want to do are limited only by
your imagination and your needs. You may want to
run a script that allows you to record your favorite TV
program from your TV tuner card. You may want to
sync the files on your laptop with the files on your
desktop or server. Or, you may wish to sync your
locally stored repository with one of the PCLinuxOS
repositories, using rsync. Whatever it is that you
would like to accomplish while you are away from
your computer, Gnome Schedule 2.12 is your
answer.

you. With very little effort, and in the right hands,
Gnome Schedule is a very powerful tool. Written in
Python and using pygtk, Gnome Schedule provides
a visual interface for scheduling tasks to be
executed by the “crontab” and “at” command line
utilities, insulating you from the command line that
instills so much fear into so many users. With a few
exceptions, which I’ll point out as we go, Gnome
Schedule follows most of the rules of crontab. You
can view those rules by checking out the online
crontab man page.

For my personal use, I’ve found the onetime task
option as the one that I use the most, since I
currently use it to record TV programs aired on an
irregular basis. However, your use, dictated by your
individual needs, may differ.
Selecting the onetime task button, you will see a
window like the one below:

By selecting the “New” button on the toolbar, Gnome
Schedule will display the following window:

While it isn’t installed by default in Zen Mini, it’s no
further away than installing it via Synaptic. Once
installed, it will be listed under your More
Applications > Configuration menu as “Scheduled
Tasks.”
Once launched, you will see a window like the one
below:

As it sits when you first launch it, it looks rather
empty, devoid of any purpose. But don’t let that fool
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Here, you select whether you want to schedule a
recurrent task (as you may wish to do when backing
up your laptop’s data to your desktop every Sunday
night after you’re customarily in bed and your
computer isn’t routinely in use), schedule a onetime
task (as you may wish to do when recording the
airing of one of your favorite movies), or if you want
to schedule a task from a predefined template.

At the top of the dialog box, you can give a title to
your scheduled task. This helps keep your tasks
separated and easily identified, especially when you
have multiple tasks scheduled. If your task launches
a GUI’d application that uses X, then check the box
next to “X application.”
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Next, enter the date and time you want your task to
start. You can enter the date directly, or you can use
the “Calendar” button to select the date. If you
choose the latter, the date fields will automatically be
filled in for you. When filling in the time, hours are
expressed based on a 24 hour clock. Thus, 8 p.m.
becomes 20 (12 + 8), 4 p.m. becomes 16 (12 + 4),
and 11 p.m. become 23 (12 + 11). The minutes are
simply entered directly, ranging from 0 to 59.

If you have everything set up properly, you will see
the frequency of your recurrent scheduled task
under the “Preview” pane of the dialog box. Once
everything is as you like it, click on the “Add” button
to add your recurrent task to the list of scheduled
tasks. Selecting “Cancel” discards all of your
selections. Clicking on “Add as template” adds your
task as a template for later reuse.
Selecting the “Edit” button on the Gnome Schedule
toolbar will display the appropriate dialog box
depicted above, depending on whether the task is a
onetime or recurrent task. Clicking on the “Delete”
button will delete the currently selected task. To run
a task now, instead of at its scheduled time, click on
the “gears” icon on the toolbar. The next icon allows
you to manage your saved templates.

Below, in the “Task” area, simply enter the command
that launches the application(s) you want to run at
that scheduled time. Once you have everything as
you like it, simply click on the “Add” button. If you
change your mind – or screw things up badly – you
can click on the “Cancel” button to discard your
choices. Clicking on the “Add as template” button
allows you to save your scheduled tasks as a
template, so you can reload it again for later reuse.
However, if you choose to schedule a recurrent task,
you will get a different dialog box, like the one shown
at the top of the next column.
Things become a bit more complicated when
scheduling recurrent tasks. Just as when you are
setting up a onetime task, the first line in this dialog
box allows you to provide a title for your scheduled
task. The second line is where you put the
command(s) that you want to be executed.
The next control is a button that brings up four
choices: default behavior, suppress output, X
application, or X application: suppress output. The
default is the first choice, default behavior. This
allows you to specify the behavior of the application
you are running.
Even though grayed out in the image above, your
next choice is the “Basic” control. Here, you select if
you want your recurrent task to run every minute,
hour, day, week, month or at every reboot. If you
select anything other than running your task at every
reboot, you will want to move the selection from
“Basic” to “Advanced”
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Under “Advanced,” you specify the minutes (059),
hour (023), day (131), month (112) and weekday
(06) you want your recurrent task to execute. The
latter setting, “Weekday,” recognizes 0 as being
Sunday, and 6 as being Saturday.
Alternatively, you can use the first three letters of the
names of the days of the week (sun, mon, tue, etc.)
and the month (jan, feb, mar, etc.) in place of the
number designations. Normally, with crontab, case
does not matter when using the names of the days
of the weeks or the months. Thus, sun, Sun, SUn,
suN, sUN and SUN all mean the same thing. But
under the Gnome Schedule environment, you can
only use all lower case letters. Otherwise, you will
see an error message displayed under the “Preview”
pane of the dialog box.

The sixth icon allows you to select from a basic or
advanced view of the tasks displayed in the task
pane of the main window. Personally, I can’t see a
whole lot of difference between the basic and
advanced view, other than a rearrangement of the
columns of information. The next to the last icon
launches the help file for Gnome Schedule, if you
happen to have it installed. The last icon displays
the “About” dialog box for Gnome Schedule, when
selected.
Summary
Because Gnome Schedule is a Python app, it
doesn’t pull in a lot of Gnome dependencies. As
such, Gnome Schedule is included on my Xfce
installations, which is where I first “became friends”
with it.
Gnome Schedule is a powerful tool
to perform tasks at a time when
typically isn’t in use, like while you
also allows you to run virtually any

that allows you
your computer
are sleeping. It
command on a
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schedule. The latter is the way I use it. I have some
custom scripts (meaning ones I wrote myself) that I
run to record “The Walking Dead” off of my TV tuner
card every week when it airs.
Gnome Schedule goes a long way in buffering the
user from the often perceived complications of trying
to handcode a crontab entry yourself, on the
command line. You definitely owe it to yourself to
give Gnome Schedule a look and discover how it
can help you automate some routine tasks that you
may repeatedly perform on your system.
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Gnome 2.32: Gnome Games
by Meemaw
While I’m not a big gamer, I do occasionally like a
game or two. In Gnome, I installed the package
Gnome Games. It is a collection of many popular
computer games. The Gnome Games Wiki says:
GNOME Games is a collection of fifteen small "five
minute" games in a variety of styles and genres for
the GNOME desktop.

Gnometris is
a version of
the
classic
game Tetris,
where different
shapes
fall
and one must
arrange them
so each whole
horizontal line

In Nibbles (center, bottom), you control a worm or a
snake. You are moving around the board eating
diamonds (the round yellow circle at the lower right
of the board). You are competing with up to 6
computergenerated worms competing for the same
diamonds. Every time you eat one you get
longer,and walls appear in other levels, so
navigation around the board gets more difficult. If
you run into a wall or another worm, you start over at
the length you were at the beginning of the game.
In Robots, you are in a space with several Robots
trying to kill you. You can use your mouse or
keyboard to move away from them or use a limited

The game icons shown above from left to right are
Lights Out, Five or More, Four in a Row, Chess,
Gnometris, Iagno, Klotski, Mahjong, Mines, Nibbles,
Robots, Swell Foop (or Same Gnome), Tali,
Tetravex, and Sudoku. However, besides the games
the wiki shows at the top of the main page, I got
Aisle Riot Solitaire, Blackjack and Freecell Solitaire
but not Lights Out when I installed the PCLinuxOS
package.
I think it is a nice assortment of games! You get a
few arcade and board games, some are puzzle, and
some are card games. In this article I will show a
screenshot of each game in the PCLinuxOS
package, and give a brief description of each.
In the Arcade section are Gnometris, Nibbles and
Robots.
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is complete. As soon as it is, the
line disappears and all tiles drop
to the bottom. As you proceed
through the game the shapes
drop faster. If you fill up the board and a shape can’t
drop, the game is over.

number of ‘teleports’ to get away. Your aim is to get
them to collide with each other and explode. If you
can escape and blow them all up, you win.
In the Boards section, you have Chess, Five or
More, FourinaRow, Iagno and Mahjong.
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orange marble in the lower left corner to the vertical
line of orange marbles to cause them to disappear,
but the pink one next to the top on the left can’t be
moved because there are marbles surrounding it.
The game is over when the board is full or empty.

This is classic Chess (which I have never played).
You can configure it to show a 2D or 3D view.
In
Five
or
More, your aim
is to clear the
board by lining
up five or more
of the same
color
marble,
while the board
is filling with
marbles. You
can click on
one and move
it to where you
want it, if there
is open space
on the board.
For example, I
can move the
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FourinaRow
is the same as
the commercial
game, Connect
Four. You play
against
the
computer,
dropping
your
pieces from the
grey area at the
top, while the
computer does
the same. You
have to make a
line
of
four
pieces in any
direction, while blocking the computer from doing the
same thing. As you can see, I have lost to the
computer as its blue pieces have already formed a
line of 4 across.
Iagno
(right)
is
the Gnome
version of
Reversi.
You play
against the
computer.
When you
place
a
piece
on
the board,
all of the
computer’s
pieces in
between
two
of
yours are captured and change to match yours.

However, computer can then place another piece
and capture any of yours that are between its two.
The game is over when the board is full. The winner
is the one with the most pieces.
Mahjongg is, of course, the classic matching game.
You click on two matching tiles and they are
removed from the board. The aim is to clear the

board in the least time possible. The catch is that
you can’t remove a tile that is ‘blocked’  that is, if
there is a tile on each side of it. A tile has to be
‘open’ on at least one side to be removed. In the
partially finished game above, the tile at top left has
a match in the right side of the third row from the
bottom, but it can’t be used yet because it’s blocked.
The tile with the 4 dots to its right has to be removed
first.
In the Cards section are Aisle Riot Solitaire,
Blackjack, Freecell Solitaire and, for some reason,
Tali.
Aisle Riot Solitaire contains 86 different versions of
Solitaire. When you open it for the first time, the
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another card, or using the ‘H’ to Hit and the ‘S’ to
Stand. Your balance is down in the status bar.

The Puzzles section has some of the previously
mentioned games, plus Klotski, Mines, Same
Gnome, Sudoku and Tetravex.
In Klotski (next page, top left), you have to move
the large blue square out of the board through the
opening where the green squares are. To do that,
you must move the small blue squares out of the
way so your path is clear. The green squares don’t
move, and the large blue square is the only square
that’s allowed out of the outer frame. You have

default starting game is Klondike. You can choose
the game you want to play by clicking on Game >
Select Game. I play Klondike, Freecell, Spider and
Gaps, but there are plenty more from which to
choose!

You are playing Blackjack (above) against the
computer. You can choose how much to wager, and
play the hand however you wish, clicking to deal
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If all you ever play is Freecell (above), then having
that as a standalone game is pretty handy.

While it is in the cards section, Tali is actually a dice
game. It’s the Gnome version of the popular game
Yahtzee. You can play against up to 5 computer
opponents. Each turn is 3 rolls, during which you are
trying to get the highest score for each category.
You keep the dice you want and roll the rest.

solved the board when the large square is placed
over the four small green squares in the lower right
of the window. The window shown is level 1, and
they get much harder!
In Mines, you are trying to find and mark mines that
are hidden on the board. When you carefully left
click on a square, the numbers that appear show
you how many mines are in the vicinity so, hopefully,
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of the grid can ONLY have one of each number,
PLUS each line and column can have only one of
each number. So... if you are filling in the darker
square, that 3 x 3 section already has 3, 4, 7 and 8,
so your possibilities are 1, 2, 5, 6 and 9. However,
the line that square is in has a 9 in it, and the column
it’s in has a 2 and a 5, so your choices are narrowed
down to 1 and 6. Once you decide which one will
work, do the rest of them the same way.

Bricks Breaking or in KDE as Same Game. You click
on a group of 2 or more likecolored balls, and they
disappear. Any balls above them fall down into the
empty spaces. Your aim is to clear the board.
Tetravex is a number matching game. Your aim is to
place the tiles into the board on the left in such a
way that when you are finished, the tile edges that
you place side by side have the same numbers. I’ve
placed one in the center. The one I place to its right
will need to have a number 5 on the left side to
match the right side of the tile I’ve already placed.
When all tiles are placed, all numbers must match.
Synaptic also adds another menu item to Games.
The Other section has Tali and Same Gnome in it.
Have fun with Gnome Games!

you can mark what you believe is the location of
each mine (by rightclicking the board in that spot).
Sudoku is the number puzzle where you fill in the
numbers 1 through 9. The catch is that each section

Same Gnome (top right) is a game we see
everywhere. On the Gnome Games site, it is also
called Swell Foop, but I’ve also seen it on Yahoo as

Visit Us On IRC

• Launch your favorite IRC Chat Client software
(xchat, pidgin, kopete, etc.)
• Go to freenode.net
• Type "/join #pclosmag"
(without the quotes)
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by sarcastic_bastard (David Lally)

Some PCLinuxOS Gnome
Post Installation Tips

The following is a list of common tasks I find
necessary to do after install and rebooting, as well
as a few extras that have been worked out over time
to fix a few annoyances. I thought by putting all of
this in the one spot, it might be of help to someone,
and can look thru and see what steps you may have
left out that you might think are useful to you.
Ok, downloaded and installed Gnome on my main
desktop, dualbooting with Win7 (which I need for
certain work requirements). I give 12 GB to /, 4 GB
to swap, and the rest (180 GB or so) to /home.
I have another box with Mint 9 that i use as a central
repository for all my files, acting as a fileserver (via
NFS and Samba), torrent box (Transmission), and
as a BOINC client. Since it’s free most of the time, it
may as well be doing something useful.
After installing and rebooting, setup with root and
user credentials, then log in. For myself, I setup as
root, then logged into it, since I needed to change a
couple things for the user ID, due to the Mint 9 user
ID. Went into Control Center and created user and
group “david,” and manually set the user ID to 1000
instead of 500 (which is the default). A user ID of
1000 is what Mint/Ubuntu uses as default, and I was
having share issues (with earlier installs) until I clued
on to why. Set that up, log out of root, and then log
in as user.
Open terminal, “su” to switch to root, and run
“echo e "MDV_MENU_STYLE=upstream"
/etc/sysconfig/menustyle”

PCLinuxOS Magazine

>>

to change the PCLinuxOS Gnome menu back to the
standard Gnome menu, as I much prefer its
categories and layout. I personally find the standard
Gnome menu much easier to work with, but you may
be happier with it as it is.
Move the Show Desktop applet from bottomright to
bottomleft. Rightclick on it and untick "Lock to
panel", then do same to the little "Window List" icon
at bottom right. Then right click on the Show
Desktop icon again, and select "Move", dragging it
all the way to far left, leaving Window List icon (the
little upright rectangle with a dot at the center) just to
the right of it. Then right click on both and lock them
in place again.
Add the Trash applet next to the Workplace switcher
at the bottomright. Right click on the bottom panel,
and select Add to Panel. Select the Trash applet
from the list available, dragging it down to the
bottom right. I stick it just to left of Workplace
Switcher icon, but you may prefer the right, or
somewhere else altogether. I definitely find it useful
having it just a click away.

Open Control Center > System > Manage Date and
Time. Set to my/your country and locale. Enable
Time Network protocol, and select server nearest
my/your location
In Control Center, go to Network and Internet > Set
up new network interface. Choose wireless/
ethernet/however you connect, then your network
interface (eg. eth0) , then for “Please select your
connection protocol” I recommend leaving as the
default “Automatic IP”, then for IP settings, leave at
“Get DNS servers from DHCP” checked (this
ensures your IP is set by your router’s DHCP
server), while making sure to set your hostname
below (whatever name you want your PC called on
the network). Complete the setup with defaults, and
finish. If you are already connected, it will
momentarily close the connection and recreate it,
with the added details now. Wireless connection will
ask for your wireless password during setup. Be
sure to enter it correctly, as it is easy to fail to
connect if you get it wrong. Your connection sets up,
and your PC now has a properly set hostname.
Even if you run thru Ethernet, and are already
connected, I still suggest doing this. It will at least
provide the PC with a proper hostname.
Open Synaptic, and select the repo to one nearest
me/you. Then, click on Reload so it has the most up
to date list of packages on the repo. I choose
Internode, since it is close, well maintained and
regularly updated. Check to see if your ISP mirrors
the repo. If so, it should be faster for you. If you are
an Internode customer, you’ll be able to download
from it quotafree. I used this a lot when I was using
them at one house I was at.
Rightclick on the clock at the top right, select
Preferences, and make sure details are correct
(Location, Weather details, etc). Set up properly, you
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should get your local weather shown beside the
clock, which is quite handy.
Ensure all drives are mounted correctly in the
PCLinuxOS Control Center. They should be, but
often your Windows drives/NTFS are not, and that is
up to you whether to leave then unmounted or not.
Set up Video card in PCC. I like to do this to make
sure it is using the Proprietary driver for my Nvidia
card, as I want/need hardware acceleration.
Use the chown command (as “root") in a Terminal to
reclaim ownership of the files on my storage drives
(eg. “chown R david:david /media/MY_STUFF
/media/STORAGE1TB /media/Hitachi1TB”).
Open Nautilus, go to Edit > Preferences > Display.
Set the top option to size, the second option to type,
then Ok and close. Feel free to experiment and see
which settings suit you best. I find this works for me.
Also, make sure to untick “Show hidden files and
folders.” Otherwise, you’ll have the view of all your
“hidden” folders clogging up your view.
In Nautilus, I also drag all my commonly accessed
folders to the left pane as shortcuts. This saves me
a lot of time chasing them down, and makes them
easily accessible.
I installed Guake, a dropdown terminal, as I like
having a terminal at hand, without getting in the way,
or needing to be launched separately all the time.
Once installed, run it, then it will be sitting in your
tray ready to be used. By default, F12 will activate it,
dropping it into your view, and F12 again will make it
retract. To ensure it starts automatically when you
login, go to System > Preferences > Startup
Applications, and look for Guake. It will be there, but
not ticked/activated by default. Enable, and enjoy.
You'll find it very handy if you use command
line/Terminal at all.
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Install Comix as a reader for my digital comics (.cbr
and .cbz files). Make sure it is set as the default
viewer. Otherwise, it attempts to open them with the
Archive Manager, which is no good for viewing
them.
Install Dropbox and set it up. I find it handy to keep a
copy of certain files and documents at all times at
hand, and when moving around from the desktop to
the netbook, to the notebook, and other desktops in
the house, it's much simpler to keep them all
synchronised and at hand. I used to copy them
around, but those changes weren't always copied if I
was forgetful. Dropbox fixes this.
I install and use Kompozer for simple webpage
creation. I came up with the idea a while ago, as I
tend to forget to save my bookmarks and assorted
fave sites, so I created a simple Homepage and
added all the sites I commonly visit (here included),
as well as add anywhere new I find of interest and
want to make sure I can find again (my memory is
pitiful). Simple page, add the links, then
names/descriptions. I save this in my Dropbox
folder, so any changes/additions I make are
reflected across all copies, and it's always up to date
with my wanderings.
Next, I install privoxy (http://www.privoxy.org/) from
the repos. I use it to filter out a lot of adverts and
assorted cr*p on the web. Since I tend to use and
install multiple webbrowsers (Firefox, Chromium,
Opera, etc) it's simple to install, then make sure that
browser is set to point at it as a proxy. In Firefox, go
to Edit > Preference > Advanced > Network >
Settings, set to Manual Proxy Configuration, then set
HTTP Proxy and SSL proxy to 127.0.0.1 and the
ports to 8118 for both. Now, all your webtraffic is
filtered thru Privoxy, and a lot of junk is never
loaded.
For a lot of good Firefox extensions, I go here
http://www.gnu.org/software/gnuzilla/addons.html.
These are all Free, and released under Free
Software licences. I've discovered a few nifty ones

here that I had not even heard of before. There are
far too many to wade through on the main
extensions site. My main ones are Scriptish
(Greasemonkey fork, seems to work better),
Greasefire (when you are on a page/site, it can
show you what scripts are available for the site, etc),
Secure Login (operates like Opera’s “Wand" and
enables you to login to sites you visit with one click,
after you’ve logged in then first time and it
remembers your details) and DownThemAll (mass
downloader). Aside from those, my faves are the
Evernote extensions (only started using this a
month or so ago, and it is sooooo useful), Flagfox,
Video Downloadhelper (for ripping vids and picture
galleries from sites, including Youtube, etc),
Ghostery (https://www.ghostery.com/, very handy,
since it blocks a lot of sites snooping on your
browsing, also shows the surprising number of sites
that follow you around the web), HTTPS
Everywhere (automatically makes sites use HTTPS
for added security if available), and Social Fixer
(previously BetterFacebook). There's plenty to
choose from.
I also install the Netusage extension for Firefox also
(http://netusage.iau5.com/). It's great for me, but
could also be useful for others to keep track of their
net usage, and how much quota is used/remains. It’s
a must. You install it, restart the browser, go to View
> Toolbars > Customize, and drag it onto your
browser bookmark where you like, then rightclick on
it, and choose Preferences, adding your details so
that it can grab your stats from your ISP. I have mine
set to update hourly. It's very useful, allowing me to
keep good track of my usage.
Oh, and before I forget, install libdvdcss2 if you plan
to be able to play/read/rip/backup encrypted
(commercial) DVDs. I also install DVDDecryptor
under WINE (after installing WINE, of course) to rip
my DVDs to hard drive, where I usually then point
Handbrake (which is also a strong recommendation
to install) at them to rip the disc contents to a .MKV
file (or, if you prefer, MP4) for local playback. This
spares
my
discs
from
excessive
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movement,scratching, fingerprints, etc, since I do
most of my viewing at my PC anyway, and only dig
them out if actually planning to use the (region
unlocked) DVD player with the TV. Also, if using
DVDDecryptor, when you first run it, it won’t see the
DVD drive on your machine. Go to Tools > Settings
> I/O, and change it to ASPI, and OK. Also, by
default it rips them to a folder inside the WINE folder,
which means you have to burrow down after them. I
change this by going to Tools > Settings > General,
go to Default Destination, and switch from Choose
Automatically to Semi Automatic, allowing you to
designate a folder to save the unencrypted results
to.

LinPC.us

Screenshot
Screenshot Showcase
Showcase

For excellent CD rips, I prefer Rubyrippergui, and
set it to rip them to both OGG and FLAC. The
OGG’s are for loading onto my Samsung Galaxy
phone (saves room), and the FLAC’s are for playing
from PC, etc (better quality, lossless sound).
GPrename is an excellent bulkrenaming utility. I
used to use Pyrenamer, and it’s still good, but I find
GPrename to have just that bit more options and
features, so it wins.
I sometimes download from certain sharing sites
(Rapidshare, etc), and for that, jDownloader is
excellent, and proven to be best of all the tools I’ve
tested for this purpose, as well as being cross
platform (also available on Windows). It also can be
used as a general download manager. It’s not let me
down yet.
VideoCut is an open source desktop application
specialized for creating compositions of screenshots
from video files. I use this to create a screenshots
sample with each DVDrip. It’s quick and simple.
If you haven’t already done so, log out and back in
to allow most changes to take effect. Now you
should have a desktop that caters to virtually all your
needs. If not, search and add more. Choice is a
wonderful thing.
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Posted by ongoto.
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Gnome 2.32: GNote & Glista
by Meemaw
Sometimes you just want a simple little notetaking
program, or maybe just a sticky note to remind you
of things you have to do. Gnome has a couple of
handy little programs just for those types of tasks.
GNote, according to the Gnome Live Wiki, is the
same notetaking application as Tomboy. When you
start GNote for the first time, you get the window
shown below, which introduces you to the program.
which corresponds to the number of notes you have
created. (For me, this was New Note 6.) You should
highlight that title and change it to something more
meaningful. From the window above, you see the
titles of my notes. Nothing complicated, but
meaningful to me.

GNote will put an icon in your system tray, and if you
wish, that’s all you will see. Left clicking on the icon
(yellow square in lower right corner) will pop up a
menu with your existing notes and the option to
create a new note. If you open a new or existing
note, it can stay on your desktop as long as you
wish.
If you choose ‘Create New Note’, a window will pop
up labeled ‘New Note #’ The # designates a number,
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These can evolve into an outline of sorts. Your main
note has a list of items in it, and each item can be
‘linked’ to its own note. In my job, I do a newsletter
which contains many articles about recent
happenings or coming events. In the note below, I
have listed many items that may be in the upcoming
newsletter. By highlighting one of the items, and
clicking on the second tool in the toolbar (the arrow
which circles around and points to a dot), you can
link the item to a new note with that item as the title.
In the new note I can write the article, list the major
points or even link that note to another one.
Another feature of GNotes is that you can place your
notes into Notebooks to organize them even more. I
have two notebooks so far: Meemaws and Work. All
the notes from my job are in the Work notebook, and
the magazine notes are in the Meemaws notebook.
From the menu, you can create a new note by itself,

or you can choose to create a note inside a specific
notebook. Those choices are at the bottom of the
menu.

The toolbar on each note has a couple of handy
items. The button that looks like a paper with an
a,b,c on it is the text properties button. You can
format your text using this button.
The next tool (gear) is the note tools button. You can
export the note in html, print the note or see what
note(s) are linked to it. There are a few other tools
you can get, but these are the program defaults.
The red X is, of course, to delete your note. Make
sure you really want to delete it! The last icon
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You will now see the subject at the top of the
window. If you have more than one subject for a list,
they will be arranged in alphabetical order.

When you complete the task list, simply click the box
at the right of the clipboard. That is Glista’s
indication that the task is complete and Glista puts a
line through the task title (next page, bottom).

(looking like a notebook) is to insert the current open
note into the notebook of your choice.
Program preferences are available when you right
click the GNote icon in your tray. To close GNote,
the rightclick menu also has the choice "Quit”
Glista is a simple todo list program. According to
the Glista website, it is written in Gtk+ so it
integrates well with the Gnome desktop.
Glista also puts an icon in your system tray when
you start it. But when you leftclick it, you get a
single window. You can enter the subject for your list
in the line at the bottom, then click the plus sign to
the right.
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Notice in the list, two of the subjects have a little
clipboard icon to the right. This means that items
have been added to the lists. As soon as I added
items to the Grocery List, the clipboard appeared
there, too. If you doubleclick the title of the list, you
can change the title. If you doubleclick the
clipboard, the list appears in the bottom of the
window. In addition, singleclicking the clipboard at
the top will open the list at the bottom for whatever
task you have chosen (next page, top).

When you need to clean up this window, simply click
the “Clear Done Items” button, which looks like a box
with the left side pointed, containing a white X. All
your completed tasks will be removed. To remove a
single task, even if you haven’t marked it as
completed, choose it and click the red X. To close
the program, rightclick the panel icon and choose
Quit.
These two programs are small, but very useful.
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Gnome 2.32: Customize Your Menu
by Paul Arnote (parnote)
As you might imagine, since Gnome is one of the
two most popular desktop environments for Linux,
there are a lot of applications that allow you to tailor
Gnome to better reflect how you work with it. The
ability to customize your Gnome menu is no
exception.
Stock Gnome Menu
Before I go showing you custom Gnome menu
configuration applications, we should first briefly
review the layout of the stock Gnome menu. As I
previously pointed out when we started the series on
Gnome 2.32, a “freshoutofthebox” PCLinuxOS
Zen Mini installation does not use the typical Gnome
menu and panel layout. In fact, one of the first things
I did after installing Zen was to return Gnome 2.32 to
its more usual appearance with two panels and the
usual Gnome menu items.

The stock Gnome menu
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Under the “Applications” entry of the stock Gnome
menu, you will find all of your installed applications
neatly arranged into the standard menu structure
used for PCLinuxOS.
The “Places” menu gives you quick access to a
selection of common folders in your home directory.
If you want a folder to show up in the places menu,
simply drag the folder from the right pane in Nautilus
to the lower left pane.
The “System” menu holds the menu entries for
governing
Gnome’s
preferences,
tools
for
administrative tasks, the Gnome Control Center,
plus the Gnome about box and options to lock your
screen from prying eyes, logging out the current
user, or shutting down your session or computer.
Alacarte
Alacarte is the Gnome menu editor. You can launch
it from a terminal session by typing alacarte & on the
command line, or by selecting the “Main Menu”
application from Applications > More Applications >
Configuration menu entry.

Gnome's Alacarte menu editor.

Taking a look at the Alacarte window, it is quickly
apparent how easy it is to use. Simply click on a
menu item’s check box, checking or clearing the
check next to it.
In case you can’t fathom why you might want to edit
the Gnome menu, let me provide a possible
scenario for you. Say you are setting up a computer
that will be used by multiple users. As the
administrator, you can go in and remove menu
entries in the Applications menu that you may want
to limit access to. Alternatively, you can use Alacarte
to “clean up” the Application menu of items you
rarely or never use. In either case, the application is
still installed and can be accessed by a
knowledgeable user from the command line, but the
menu entry can be toggled on or off to suit individual
tastes and needs.
Because Alacarte doesn’t pull in a lot of Gnome
specific dependencies, it is also used as the defacto
menu editor for Xfce – at the moment. It can also be
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used to help manage the menu entries in other Linux
desktop environments, like LXDE.
AGM: Advanced Gnome Menu
The Advanced Gnome Menu is a panel plugin
written in Gtk+ and Python that is supposed to allow
users to create their own custom menu, filled with
their most commonly used applications.
Unfortunately, Advanced Gnome Menu hasn’t seen
active development since 2009, and the web site
where you could download all the AGM plug ins is
now defunct. While the source code is still available
on the opendesktop.org web site (good for anyone
who may wish to pick up the development reigns on
this), AGM is of very little use without the plug ins.

Also, since Gnome has moved on to the radically
different 3.x version, it’s doubtful that anyone is likely
to resume active development on this promising plug
in.
Mint Menu

Selecting the “All applications” button in the upper
right corner of the initial view brings up the view,
shown above, that shows all of the application menu
entries. They are either all shown, (as in the image
below), or you can choose to view each subsection
of the Gnome application menu to view the
applications by sections.

Named after the Linux distro where it originated, the
Mint Menu provides a neat, modern and organized
appearance to the traditional Gnome menu that is
very easy on the eyes.
Mint Menu also exhibits some flexibility regarding
how it runs. It can run as a standalone application in
a window on your desktop (like above), or you can
run it as a panel plug in, which is the most likely way
to use Mint Menu.
Summary

Mint Menu main appearance.

Initially, Mint Menu opens to a screen displaying
your favorite applications on the right twothirds of
the screen, while Places and System entries appear
in the left onethird of the screen.

AGM: Advanced Gnome Menu.
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As you can see, Gnome provides several utilities to
allow you to customize your Gnome menus. While
Gnome has been often criticized for deliberately
hiding configuration settings from their end users, it
has also opened up the possibilities for additional
apps to be written that fit well into the Linux way of
doing things: apps that do one thing, and do it well.

Mint Menu viewing all applications.
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Gnome 2.32: Guake & Other Popup Terminals
by Darrel Johnston (djohnston)
There are a few dropdown quakelike terminals
available for Linux users. Yakuake is the one
associated with the KDE desktop, and has quite a
few Qt4 dependencies. Tilda can be used with most
any desktop, and basically has only libconfuse as a
dependency. Tilda's last package was released on
June 29th, 2006, and is no longer in the PCLinuxOS
repositories.

My guake terminal is shown below. It usually has
two tabs open with a folding@home client running in
each tab. It also has some translucency, as well as
text in the color I chose. The icon showing on the far
left of the bottom window frame is simply a
decorator. The buttons to the right of it are tab
selectors. Each time a new tab is opened, an
associated tab button is generated. The button to
the far right is for adding a new terminal tab to the
window.

Copy, paste, close tab and quit are other options
selectable by rightclicking on the running guake
window.

Terminator creates a window in which you can
arrange multiple terminals in a grid. Version 0.95 is
in the repositories. Version 0.96 has dropdown
capabilities, but is still only available as testing
packages and source code.
stjermterminal is another quakelike dropdown
terminal. The source is available from Google code.
vterminal is described as "a dock and DE
independent terminal applet for the masses." The
source is available from SourceForge.

The guake terminal has a few options. The first time
the application is launched, the Guake properties
window will be launched. The window has 5 tabs,
each tab having a different set of configuration

YeahConsole turns an xterm into a gamelike
console. This means it will slide down from top of
your screen if you hit a shortcut key. It is associated
with the YeahWM project and is available as source
code.
In addition, there are web tutorials on how to
configure gnometerminal, konsole, xfce4terminal
and urxvt into dropdown terminals. We will be
looking at the guake terminal, which is commonly
associated with the Gnome desktop, and is available
in the PCLinuxOS repositories. It has few
dependencies, mostly python packages, and works
well on almost any desktop.
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options. After configuring guake and closing the
window, the terminal will be running. Further
configuration can be done by either selecting More
Applications > Terminals > Guake Preferences from
the main desktop menu, or by rightclicking on the
running guake terminal and selecting Preferences.

Beginning with the General tab, we first have the
shell options. Default interpreter has a dropdown list
of all installed user shells, with user shell being the
default option. On PCLinuxOS, the user shell is
generally /bin/bash unless the user changes it. Run
command as a login shell is an option to do just that,
login as a different user via a terminal emulator.
Open new tab in current directory will begin the
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guake session with two tabs open, the second one
being in the user’s desktop directory. I imagine this
is for those users who download executables to their
desktop and wish to run the executables from a
terminal.
In the general options section, the first is an option
to show a guake icon in the system tray or not.
Enable popup notifications on startup will show
startup messages on the desktop when guake is
started. The next option is whether or not to prompt
the user when the application is closed.
In the Main Window section, the stay on top option
determines whether the window is above or below
other windows on the desktop. Hide on lose focus
determines whether the window will disappear when
the desktop or another window is clicked. If
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unchecked, the same keybinding that drops the
window down will also hide it. Show tab bar is
whether or not to show the bottom window
decoration panel.
The Main Window height is set by using a slider bar.
Selecting the Scrolling tab, we have two main
sections. In the General section, the show scrollbar
option determines whether we have a method to
scroll backwards through the screen. The number of
scrollback lines can be selected.
In the Scroll section, I’m not sure what scrolling on
output option does. The text scrolls down the
window normally without this option selected.
Scrolling on keystroke determines whether or not the

mouse can be used to scroll backwards through the
screen’s output.
Selecting the Appearance tab, we have two main
sections. In the Fonts section, selecting use system
defaults determines whether or not to use the
system’s default terminal fonts or custom ones. If the
option is unchecked, the style button can be used to
select both the font type and size. Selecting the
color button gives us a color chart to choose from.
In the Background section, the color button gives us
the same color chart to choose the background color
from. The window’s transparency level is selected
using a slider bar. Selecting the image button gives
us a file requester window from which to select a
custom image for the window’s background.
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The Keyboard shortcuts tab gives us the
keybindings window. All the actions shown are the
only ones available for guake. Doubleclicking one of
the keyboard choices allows us to input the key
binding to be used from the keyboard.
The Compatibility tab has only two item choices.
Both the backspace key and delete key buttons
have the same three options: ASCII delete, escape
sequence or ControlH. ASCII delete removes the
character ahead of the cursor’s position. The escape
sequence can be useful when connected to a
remote system which does not recognize the delete
key as input. For example the VT220 terminal uses
the key sequence ESC [3 ~ to send a destructive
backspace character. The destructive backspace
removes the character behind the cursor’s position.
A ControlH keyboard sequence is used by some

systems as either a delete key or a destructive
backspace. An ASCII 8 is a backspace character
and an ASCII 127 is a delete character.
As you can see, guake can be customized to your
personal preferences and to the situation the
terminal is meant to deal with. Being able to
reassign key bindings means that you can select
ones that don’t conflict with the keybindings of other
applications.

Visit.
Contribute.
Build.
The PCLinuxOS
Knowledge Base
It Belongs To YOU!

Screenshot Showcase

Posted by konaexpress.
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Gnome 2.32: Nine Re-Sounding Apps
by Paul Arnote (parnote)

one of the added files from the conversion process,
highlight the file and click on the “–” icon. To
completely clear the list of queued files, click on the
broom icon.

There is no shortage of sound applications that have
been specifically written for (or centered around) the
Gnome desktop environment. Of course, many of
these applications can be used in other Linux
desktop environments, as well.
The criteria for inclusion as part of a Gnome 2.32
article was a) the description in Synaptic, b) being
listed on the Gnome project site’s Module
Maintenance
list,
c)
significant
Gnome
dependencies listed for a package in Synaptic, or d)
my prior knowledge of a project belonging to (or
catering to) the Gnome desktop. For example, the
Python/Gtk+ app Exaile is a favorite of many users.
But, it is not included because it’s not dependent on
Gnome. If your favorite app isn’t listed below, it’s
simply because it didn’t pass muster when the
aforementioned criteria was applied.
So, without dillydallying around any more, let’s look
at the Gnome sound apps.

Next, click on the drop down list in the lower left
corner, and select the format you want to convert to.
If the format you want to convert to isn’t listed, or if
you want to see what parameters are applied, select
a similar codec to use and click on the “Edit” button.

Image courtesy of the Banshee web site.

You can check out more information about Banshee
by checking out the Banshee home page.
gnac: Gnome Audio Converter

Banshee
Closely associated with Gnome, Banshee is a
free/open source C#/Mono application, using the
Gnome technologies and SQLite. It attempts to
position itself as the “goto” application for all of your
multimedia needs, playing CDs, DVDs, digital music
files, podcasts, Internet radio stations, audio books
… and just about any other multimedia format you
can think of.
Unfortunately, Banshee in the PCLinuxOS repository
is broken (at the time of this article being written),
and will not launch on my copy of Zen Mini 07.11.
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Don’t let the simple interface fool you. This
application does one job – sound file format
conversion – and does it well. To get started, click
on the “+” icon and select the file(s) you want to
convert. If you make a mistake and want to exclude

You will see a list of the predefined “profiles” listed in
a dialog box similar to the one shown above. Select
the one you want to alter (or select the “New” button
on the right), and select the “Edit” button on the
right.
Using the “Edit Profile” dialog box (shown above),
you can enter all of the variables that control the
conversion of your sound file to the selected format.
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Of course, different options may be presented with
different formats, dependent upon what options your
selected format supports.

gssmp: Gnome Simple Stateful Music Player

With “simple” as part of its name, the Gnome Simple
Stateful Music Player is exactly that. To start with,
you need to choose the music you want to play. If
you want to play all of the songs in a directory,
simply choose the File > Play Directory menu item.
GSSMP will start playback of the first audio file it
finds in the selected directory, then proceed through
the other audio files there, alphabetically. If you want
to play a specific file, select the File > Play File
menu item. Then, select the file you want to play.

Selecting the Edit > Preferences menu item will
display the dialog box above. Set the general
operation preferences for Gnome Audio Converter
here. The “Audio” tab allows you to set a couple of
options for how your converted sound files are
saved. The GAC home page will fill you in on more
information.
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You can also sync your music listening preferences
with last.fm, if you choose, via the “Tools” menu.
GSSMP also remembers the last file you were
playing, and will allow you to directly access it via
the “Recent” menu, in case you had to shut down
GSSMP before you completed the playback of the
file. The rest of the controls in the application
window should be fairly self explanatory. The
GSSMP home page will provide more information for
you.

gwc: Gnome Wave Cleaner

If you are one of the many MLU’s (Mature LinuxUser
s) in the PCLinuxOS forum, you most likely have a
fairly extensive collection of music on vinyl records. I
know I do. My wife got me a USB turntable as a
present Christmas before last. In my leisure, I’ve
been converting my old vinyl records to MP3 files
that I can play on my assorted MP3 players and on
my computer. No matter how hard you try, you
cannot get rid of all the microscopic dust particles,
not to mention the years of wear from listening to
your vinyl records over and over again. Vinyl records
DO wear out with repeated playings. Invariably, you
will be left with a recording of your vinyl record tracks
that contain “pops” and “clicks.” These are the direct
result of all of that wear and microscopic dust.
Enter GWC, also known as Gnome Wave Cleaner.
It’s primary purpose is to automatically detect those
“pops” and “clicks,” and remove them from the
source file. You can run it once to get rid of the
strong clicks, then again to scan and eliminate the
weaker clicks. I recommend listening to the file after
the first pass – you may be satisfied with the results
after eliminating only the strong clicks.
As anyone who has worked with making digital
copies of their vinyl music collection can attest to,
old vinyl can also develop a “crackle” in the
background that can also detract from having a
clean digital copy. Fortunately, GWC also has the
ability to remove that background “crackle” sound.
Keep in mind that GWC only works on sound files in
the *.wav format, which is a good thing, since it is
pretty much a universal lossless sound format. So, if
you have recorded your vinyl tracks as MP3 files,
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you will need to first convert them to the *.wav
format. Don’t worry – GWC will allow you to later
resave your edited sound file as a *.mp3 file.

difference. I picked a song that I thought might give
GWC difficulty (Sammy Hagar’s “I Can’t Drive 55”).
However, GWC processed the file admirably and
without any difficulty. GWC definitely deserves to be
in your sound file editing and processing toolbox.
Check out more about GWC by visiting the GWC
home page.

SoundConverter

Listen

Prior to performing any action on your sound file, I
recommend clicking your mouse on the black bar
that separates the two sound channels (in a stereo
file), then clicking on the “Select All” icon on the
toolbar (next to last icon on the toolbar, at the upper
right corner of the GWC window). This way, you will
insure that both channels of your stereo file are
analyzed for the editing you wish to perform.
Otherwise, my initial use of GWC resulted in only the
left channel being declicked, leaving the right
channel untouched. Needless to say, I was still
hearing “clicks” and “pops” in my sound file after
attempting to remove the clicks, because the right
channel had not been cleaned.
GWC can also “denoise” your sound recording, as
well as amplify your file. Most other sound editing
functions can be done with a more complete sound
editor, such as Audacity.
Just as many other Linux applications, GWC does
one job, and does it exceptionally well. Let your ears
be the judge. I know that I could certainly hear the
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Written in Python for Gnome, Listen is a quite
capable music manager and player. With Listen, you
can playback your favorite songs, manage your
music library, manage your iPod, make playlists,
download album covers (and sync them with your
iPod), burn an audio CD, retrieve data from
Wikipedia when you play a song, view the lyrics of a
song, retrieve statistics about your favorite songs,
albums or artists, listen to web radio stations, and
access to your last.fm account.
The latest version (0.6.5) is in the PCLinuxOS
repository. While it can be used under other desktop
environments, be forewarned that it will pull in a
significant number of Gnome dependencies. You
can visit the Listen home page for more information.

Despite its simplistic appearance, Gnome’s
SoundConverter is a powerful tool that automates
conversion of various sound file formats.
SoundConverter can read any input sound file that
can be read by gstreamer, and output it to WAV,
MP3, OGG, FLAC or AAC formats. You can specify
the output format by selecting the Edit > Preferences
menu, and changing the output format in the
preferences
dialog
box.
Additionally,
SoundConverter can extract the audio from video
files.
Written
in
Python,
SoundConverter
is
a
multithreaded application, that will use as many
cores available to perform the file conversion as
quickly as possible. Because of its multithreaded
design, SoundConverter will convert multiple files
simultaneously, placing each conversion process
into its own thread. Visit the SoundConverter home
page for more information.
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SoundGonverter

Nautilus extension. In fact, Nautilus Sound
Converter uses the same configuration file as GAC.
As such, Nautilus Sound Converter works exactly
like GAC, which we talked about earlier in this
article. The Nautilus Sound Converter home page
has more information.
Summary

Soundgonverter is a sound conversion application
written in Mono, the Linux equivalent of the Microsoft
.NET application framework that utilizes the C#
programming language. Unfortunately, I can’t report
very much about this application, since the version
that is in the PCLinuxOS repository produces a
segfault whenever I attempt to run it. You can visit
the soundgonverter home page for more
information.
RhythmBox

Internet radio stations, listen to last.fm music
streams, create playlists, download and view song
lyrics and album covers, and display audio
visualizations.
Additionally, there are several 3rd party plugins for
Rhythmbox, that further extend the capabilities of
Rhythmbox. These plugins range from graphical
equalizers to adjusting the pitch and speed of your
songs. To get the full lowdown on Rhythmbox, as
well as a link to the 3rd party plugins, visit the
Rhythmbox home page.
Nautilus Sound Converter

Taking its inspiration from Apple’s iTunes,
Rhythmbox is a Gstreamer application built for the
Gnome desktop. Rhythmbox bills itself as more than
a music player. Rather, it bills itself as an integrated
music management application – and probably
rightly so.
So what can Rhythmbox do for you? For one, it can
play your music collection on your computer, as well
as organizing it and allowing you to search and sort
through the songs in your collection. It can also sync
your music collection with your iPod or other MP3
music player. You can also burn audio CDs, listen to
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As you might expect, Gnome 2.32 has a plethora of
sound applications to fit your sound file needs. While
it’s true that we left out some sound applications that
are popular with Gnome users, such as Exaile, we
did so because Exaile is not developed specifically
for the Gnome desktop environment. Even without
Exaile, the Gnome desktop has plenty of other
sound applications to fulfill your sound application
needs.

A product of a Google Summer of Code project,
Nautilus Sound Converter is almost identical to the
Gnome Audio Converter (GAC) – except, it’s a

It's easier than E=mc2
It's elemental
It's light years ahead
It's a wise choice
It's Radically Simple
It's ...
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Gnome 2.32: Gnome Panel Applets
by Darrel Johnston (djohnston)
There are a dozen or more Gnome
panel applet packages available in the
PCLinuxOS repositories. We will look
at six of them. Zen Mini comes with a
single Gnome panel at the bottom of
the desktop. I created a second panel
and placed it at the top of the desktop
so that I could keep track of the extra
applets installed, and so that the
bottom panel would not become
cluttered. Above is a screenshot of the
top panel. From left to right, the applets
are, by package name, gnometimer
applet,
gnomeappletmusic,
file
browserapplet, istream and gnome
appletnetspeed. “Wait a minute,” you
may say. “That’s only five.” I’ll cover the
sixth one at the end of the article.
gnometimerapplet
Hover your mouse over the timer applet and you will
see a help balloon stating “Click to start a new timer
countdown.”

Left click the applet and a dialog window will appear.
The countdown timer has fields for hours, minutes
and seconds. Fill in the time desired, then click the
Start Timer button. Click the Manage Presets button
to create and store preconfigured countdown
timers. I created one with a time limit of ten minutes
and named the preset “10” (above).
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depend on the music player’s ability
to show the information requested.
Right click the timer applet and
select Preferences to set them
(below).

Right click the music applet and select Plugins to
see the window below, and to select your preferred
music player. The plugins with the white bar inside a
red circle next to them have the “No module named
…” message showing.

gnomeappletmusic
Hover your mouse over the
music applet and you will see a
help balloon stating “Launch
Rhythmbox.” Rhythmbox is the
preconfigured default music player for this applet.Th
e screenshot at right shows VLC because I changed
the preferred plugin.
Rightclick the
music
applet
and
select
Preferences to
see the window
shown above
right. Note that
some of those
preferences will

filebrowserapplet
Hover your mouse over the file browser applet to
see the help balloon “Browse and open files in your
home directory”. I could find no option to change the
contents of the help balloon.

Right click the file browser applet and select
Preferences to see the window below. You can add
file browser paths with corresponding labels.
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However, each
new label will
show the same
“open files in
your
home
directory”
balloon. There
are
several
folder
view
options.
Although
the
Select applet
icon
button
allows you to
browse for an
alternate icon
image to be
used, the icon
does not show
anywhere in the panel or in the file browser
windows. The label name is what appears in the
applet. You can also select an alternate terminal and
text editor.

Shown at center top is the file browser menu that
appears when you left click on the file browser
applet. Simply navigate the menu to the folder or file
you want opened.
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istream
Hover your mouse over the istream applet to see a
summary of the song title playing. The applet is an
Internet radio station player similar to Radiotray.
None of the stations selected would show any of the
meta information associated with Album, Genre,
Comment or Location.

Left click the red icon in the istream applet to see the
radio station labels. There is no GUI configuration
for the applet. The station list configuration is stored
in a simple hidden text file in your home directory
named .istream. Shown below is the default
configuration.
#format is:
#
#<Displayed Text> (<invisible Text>)=<url>
#
#url format:
#
#http://<....>
#file:///home/user/<file>
#
#
# my radio stations:
#
Classic Rock=http://205.188.215.226:8018
Country=http://216.218.159.151:8020
Motown=http://208.53.158.48:9170
Rock=http://64.71.145.130:8070
Modern=http://207.200.96.230:8002

Urban=http://64.71.145.130:8055
Blues=http://64.62.252.130:8030
New Age=http://64.202.98.133:9130
Jazz=http://207.200.96.226:8052
Club mix=http://38.118.158.78:8070
Metal=http://205.188.215.225:8022

I changed the Classic Rock station to another URI
and commented the Club mix line. Neither of those
two stations would load for me. It should be noted
here that if a station will not load, the istream applet
will hang and refuse to respond to any mouse clicks.
It doesn’t seem to affect any other desktop
operations. The only method I found of regaining
control of the applet was to log out and log in again.
The istream applet does not automatically start
when you log in. In trying to track down radio station
URIs, I came across an excellent radio tray station
list
compiled
by
“wolfgar”. Although
the radio tray format
is a little different
than istream’s, the
important thing is
having a large list of
internet radio station
URIs, along with the
corresponding port
numbers, that can be
easily copied from.
Doing an Internet
search for streaming
radio stations can be
a
frustrating
experience, as many of the compiled “lists” are
actually just links to the stations themselves. Many
of those stations require you to listen online using a
flash player, or, worse yet, a Windows Media Player.
gnomeappletnetspeed
Hover your mouse over the
netspeed applet to see a
short
summary
of
the
monitored network device.
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gnomewindowpickerapplet
Last, but not least, is the window picker applet. This
is the one applet that did not appear in the first
screenshot of the Gnome panel. Until you open a
window, you may not even be aware the applet is
actually installed. All open windows, even when
minimized, are shown in the applet, represented by
the application’s icon. Below, you see the home
folder, PCLinuxOS Control Center and Firefox icons.
Hover your mouse over one of the icons to see its
window title.

Right click the netspeed applet to see a more
detailed summary of the monitored device.

International Community
PCLinuxOS Sites

Netherlands

Turkey
The Gnome panel at the bottom of Zen Mini’s
desktop has a Window Selector applet at the far
right side of the panel. However, using the window
selector applet, you can only select a minimized
window to be restored to the desktop. Right clicking
on any icon in the window picker applet gives you a
few choices to manipulate the application’s window,
all from the window picker applet.

Denmark

Czechoslovakia

Italy

Poland
Right click the netspeed applet and select
Preferences to see the window at above right. If you
have more than one network device, you can select
which one is to be monitored.
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These are but a few of the Gnome panel applets
available from the PCLinuxOS repositories. How
many of them will you find a use for?

Brazil
Page 44

Gnome 2.32: Shutter Shoots Screenies
by Meemaw
We’ve seen Shutter before. Some of us use it as a
simple photo editing program, and it works very well.
We even covered it in the Photo Viewer series in this
magazine earlier in the year.
Did you know that it also takes screenshots?
When you open Shutter, you get the main window:

screenshot
you
have
taken or image you have
opened, and two extra
choices
for
your
screenshot: whether or
not to include the cursor,
and the number of
seconds to delay before
your screenshot is taken.
Although not visible by
default, there is also a
navigation toolbar you can
activate at the bottom.
The tools from left to right
are sort descending (this
sorts the group of shots in
the Session tab by file
name from Z to A), previous shot, view Session tab,
next shot and sort ascending.

Your next choice is to capture a section of a
window.... I honestly haven’t figured this out, since I

When you are ready to take a screenshot, you have
several choices. Using the window tool, you can
take a screenshot of any of your desktops (Shutter
calls them workspaces) or all of them in order. If you
do all of them, Shutter will save all the shots in one
file. This (top right image) is a screenshot of my four
laptop workspaces.
The tab that’s there already is the Session tab. As
you open images or take screenshots, a thumbnail
of each will appear on the Session tab. The tools
are, left to right: Redo last screenshot, Selection
Tool, Desktop screenshot, Window screenshot,
Selection screenshot, Menu screenshot, Tooltip
capture, Website capture, Edit and Upload. At the
bottom, you will see dimensions and file size of any
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Your second choice is to take a screenshot of any
window you have open. If you are trying for a
specific window, the drop down arrow next to the
window tool will list the windows you have open so
you can choose the one you want. That way you
won’t have to crop a screenshot down to just one
window. This is how I have taken most of my
screenies for magazine articles.
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can’t seem to take a screenie of anything but a
single window with it. If I drag my cursor across it,
then press Enter or click with my mouse, I don’t get
the section of the window that I seemingly outlined,
but the whole window. If you want to take a screenie
of your panel instead of your whole desktop, it works
fine.
You can also capture a drop down menu, tooltip or a
website shot from Shutter using the next 3 buttons.
Make sure you have set a delay for the drop down or
tooltip to give yourself time to access them.
I covered Shutter in the photo editing series I did last
year. The colored icon at the right side of the main
Shutter screen is the editing tool. It will open your
active shot in a larger window, and you can crop or
edit it there This is very handy if you have taken a
screenie, but decide you want a smaller area than
what you shot, or want to add something to the
screenie (text, lines, geometric figures or an
indicator of some sort).

Full Monty ...

Everything you might want or need –
plus the kitchen sink!

Screenshot
Screenshot Showcase
Showcase

Posted by
z3r0_k00l75.
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Gnome 2.32: Graphics Extras
by Meemaw
While looking at some of the programs in Gnome, I
came across three graphics programs that we
haven’t mentioned before.
Agave is a program which can help you plan a color
scheme for a graphic creation. The Help file gives
the following introduction:
Agave is an application for the GNOME desktop that
allows you to select an initial color and generate a
variety of different color schemes from that color.
The primary audience of this application is graphic
designers (and particularly web designers) though it
can be used for anything where you might need to
pick several colors that go well together, such as
painting rooms in your house.
When you open agave, you will get the main
window:

preferred color from the color wheel window that
appears. As you can see above, I’m a fan of blue
and purple. Then you must decide what kind of color
scheme you want. You have six choices:
Complements, SplitComplements, Triads, Tetrads,
Analogous and Monochromatic. You can also use
the Palette at the bottom of the window to choose
your colors. Notice on each color chip are the color
name (303acf on the blue above at left), along with
the hue, saturation and value numbers (236, 77, 81)
and the red, green and blue values (48, 58, 207).
Using those, you can recreate any color correctly no
matter what program you are using.

Actually, it looks exactly like MS Paint to me.
However, upon use, I have found this program
barely works at all. I did manage to draw the heart
with the paintbrush, but no matter which size brush I
chose, I only got the biggest size round brush. If I
choose the selection box (at the top of the righthand
column of tools), I could draw a box around anything
I wanted, and drag the box all around the canvas,
but I couldn’t cut, copy, move or delete anything that
I had drawn. Maybe it’s me. However, clicking on the
eraser tool (second from the top in the lefthand
column), I could drag it over my whole drawing and
couldn’t erase anything.

Also in the toolbar there are two pairs of arrows. the
left ones increase or decrease the brightness of your
colors, and the right ones increase and decrease the
saturation of your colors so you can get them just
right. When you have them right, you can choose to
add that color scheme to your favorites.

The view, image and color menus have no items,
either. With all the other drawing programs I can
use, I’m going to uninstall Gnome Paint.

Gnome Paint is a simple paint program, reminiscent
of MS Paint or the older Paintbrush.

GPhotoFrame is a program which allows you to put
a frame on your desktop and run a slideshow of your
favorite photos. In your graphics menu, it is called
Photo Frame. When you first open it, you will see a
black screen with a plain frame around it. Right
clicking the black screen will give you a menu.

Using the color choice button on the left side of the
window (above the Palette) you choose your

PCLinuxOS Magazine

Page 47

Gnome 2.32: Graphics Extras
You should configure your Preferences first.

The general tab lets you configure the time between
photo changes. Window mode and full screen mode
can have different intervals. You can also set the
maximum size for the frame, have it start when you
start your computer, and have it show on whatever
workspace is visible at the time.

The plugins tab shows you the sources you can
access for your files. If configuring it to use Flickr,
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Picasa Web or Tumblr, you should highlight your
preferred site and click on the Preferences button
below. You will be asked for your user name and
password so the program can access your account
on the site. Flickr asks permission to access the site,
then takes you to a Flickr signon screen. When you
sign on, the following window appears:

If you want GPhotoFrame to access Flickr, you
should click the blue box in the center of the window
that says “You arrived at this page because you
specifically asked GPhotoFrame to connect to your
Flickr account....”. From here you complete the
authorization on Flickr, then go back to the
Preferences window in GPhotoFrame and finish the
process.

The third tab of Preferences is Photos. Here is
where you actually tell GPhotoFrame where your
photos are located. If you only want to access a
certain folder in your system, or if you want to get
them from Flickr, you need to add the location by
clicking new. Another window will appear asking you
to designate the location of your photos. I chose my
wallpaper folder.

To do a fullscreen slideshow, simply rightclick the
frame and choose Full Screen. To go back to the
frame, rightclick the slideshow and your menu will
appear again and you can uncheck the Full Screen
checkbox.
You can move the frame anywhere on your screen,
unless you rightclick and choose “Fix Photo Frame”.
This choice will ‘stickie’ your frame to your desktop
wherever it happens to be located. I have noticed
however, that even when ‘stickied’, the frame moves
on the desktop. It resizes itself every time the image
size is different, and instead of fixing a certain corner
to a specific spot (for example, the top left corner of
the frame could be fixed to the screen wherever you
stickied it), it just keeps resizing and ‘crawling’ until
the frame is somewhere else. Other than that, it’s a
very nice program, and very easy to use.
As with any program, or any desktop for that matter,
you should pick the ones that are easiest for you to
use, and work best for you.
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4 Miscellaneous Desktop Apps

by Darrel Johnston (djohnston)

An unorthodox looking font.

gnomespecimen

Wallpapoz is a Gnome wallpaper configuration tool.
You can have a different wallpaper for each
workspace, as well as having them change
automatically on a userdefined schedule. After
installing the package using Synaptic, I had no menu
entry for it. A quick look at the supplied desktop file
showed why. The original wallpapoz.desktop file is
shown below.

According to the Synaptic description, Gnome
Specimen is an application to “view and compare
fonts installed on your system.”
Gnome Specimen currently features:
 A list of all fonts available (the left pane)
 A list of font previews (the right pane)
 Configurable preview text and font size
 Configurable foreground and background colors
used in the preview pane”
Other than being able to change the foreground and
background colors of the preview, it has the same
basic preview functions as the PCLinuxOS Control
Center font manager (PCC > System > Manage, add
and remove fonts). The other difference is that
Gnome Specimen cannot add or delete system
fonts. It is a bit dated, having not been updated
since December 31st, 2007.

wallpapoz

This one is much more readable.

[Desktop Entry]
Encoding=UTF8
Name=Wallpapoz
GenericName=Wallpapers tool
GenericName[id]=Alat gambar latar desktop
GenericName[ja]=
GenericName[sv]=Skrivbordsbakgrund verktyg
GenericName[de]=Wallpaper Tool
GenericName[es]=Configurar la imagen del fondo
GenericName[fr]=Outil pour les fonds d'écran
Comment=Gnome
Desktop
Wallpapers
Configuration Tool
Comment[id]=Alat
Konfigurasi
Gambar
Latar
Desktop Gnome
Comment[ja]=Gnome
Comment[sv]=Gnome
Skrivbord
Bakgrunds
Konfiguerings Verktyg
Comment[de]=Gnome
DesktopHintergund
Konfiguration
Comment[es]=Herramienta para Configurar La
Imagen Del Fondo Del Escritorio
Comment[fr]=Outil de configuration des fonds
d'écran pour Gnome
Exec=wallpapoz
Icon=wallpapoz.png
Terminal=false
Type=Application
Categories=Utility;
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There is no proper category defined. Change the
Categories= line to what is shown below.
Categories=GTK;XMandrivaLinuxSystem
Configuration;Settings;
Save
the
edited
/usr/share/applications/wallpapoz.desktop file file to
~/.local/share/applications/wallpapoz.desktop. The
menu entry will then survive any updates to the
wallpapoz package.
To have the wallpaper changer start automatically
on login, add /usr/bin/daemon_wallpapoz to startup
apps (System > Control Center > Startup
Applications in the main menu).

When the application is first started, all desktops will
have one wallpaper defined, the currently configured
one. Each workspace will also contain the default
“rename this” for the userdefinable Wallpaper field.
Doubleclick the entry to edit it. Click on the arrow to
the left of a workspace number to see the
wallpapers that are associated with it (center, top).
You can choose to add individual files or an entire
directory’s files to a workspace. If you choose a
directory, you can also add all subdirectories by
checking the recursive option. I chose to create two
directories, one for each workspace, and store the
wallpaper images in each workspace’s folder
(center, bottom).
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Rightclicking the wallpaper group name or an
individual wallpaper in the group will bring up a
window with additional options (top, right).
This is a preview of the first wallpaper in the
Workspace1 group (center, right),
This is a preview of the first wallpaper in the
Workspace2 group (bottom, right),
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You can stop and restart the daemon by clicking a
button. Click the Preferences button to open the
configuration window.

Enter a master password.

I tried setting the change interval to 0 minutes, so
that the wallpapers would never change. But, after
saving, it reverts to 1 minute. Nevertheless, this
application offers the ability to have a different
wallpaper for each workspace in Gnome2 by
checking the Change desktop wallpaper when
changing workspace option. Click the Style pulldown
menu button to choose the method of scaling the
wallpaper image to the desktop.

Here is workspace number one showing one of its
wallpapers (center, top).
Here is workspace number two showing one of its
wallpapers (center, middle).
gpass
The GNOME Password Manager lets you manage a
collection of passwords. The password collection is
stored in an encrypted file, protected by a master
password. GPass encrypts the password file by
using Blowfish encryption. It has a heavy
dependency on a full Gnome desktop environment.
Its functions are similar to Keepass and Revelation.
This is another dated application, as the last version,
0.5.1, was released on March 25th, 2006.
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Click the Add button to add a password for an
application.
Once installed, the menu entry is in the Office
section of the main menu. The first run window is
shown below.
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gnomepim
The GNOME Personal Information Manager
currently consists of:
 gnomecal : personal calendar and todo list
 gnomecard: contact list of friends and business
associates
After installing the gnomepim package using
Synaptic, I had no menu entries for these
applications. There is no desktop file included for the
Gnome Calendar and Planner application, so I
created my own and stored it in the
~/.local/share/applications directory. The contents of
the desktop file are shown below.
gnomecal.desktop
[Desktop Entry]
Encoding=UTF8
Name=Calendar & Planner
Comment=Manage
your
appointments
deadlines
Exec=/usr/bin/gnomecal
Terminal=false
Type=Application
StartupNotify=false
Icon=/usr/share/icons/gnomecal.png
Categories=Utility;XMandrivaLinuxOffice
Accessories;GTK;
XDesktopFileInstallVersion=0.11

Comment=Manage your contacts
Exec=/usr/bin/gnomecard
Terminal=false
Type=Application
StartupNotify=false
Icon=/usr/share/pixmaps/gnomegnomecard.png
Categories=Utility;XMandrivaLinuxOffice
Accessories;GTK;
XDesktopFileInstallVersion=0.11

The contacts list is a standalone application. None of
the contact information can be shared with other
applications, making its use somewhat limited. I
should also add that both the Personal Information
Manager applications look outdated, as if they were
designed with GTK version 1.

I found the calendar and planner to be a bit counter
intuitive. You can add an item by selecting a day,
then clicking on the time period in the left pane.
Even if you enter the beginning time as the half
hour, the planner enters the item as beginning on
the hour. Once an item has been added, it cannot be
edited or deleted, except in the Todo list Summary
area. Also, there are no alarms or notifications given
when an item is due. You have to open the planner
application to scan the entered items.

and

The Gnome Contacts Manager had a desktop file in
the /usr/share/gnome/apps/Applications directory,
but the file had no Categories= entry at all, and did
not show in the menu. Again, I created one and
saved
it
as
~/.local/share/applications/gnomecard.desktop. The
contents are shown below.
gnomecard.desktop
[Desktop Entry]
Encoding=UTF8
Name=Contacts Manager

PCLinuxOS Magazine

Page 52

Gnome 2.32: Say Cheese!
by Meemaw
As technology advances and we communicate with
each other more and more, we don’t just want to text
back and forth with old friends across the country,
we actually want to see them as well. So we get a
web camera to use on our computer, or have one
already on our laptop. Now we need a program that
will run our webcam. In PCLinuxOS, we can use
Cheese.
The website is http://projects.gnome.org/cheese/. If
you click on the tour links, you can learn all about it:
“Cheese is a program for the GNOME Desktop
which allows you to take photos, videos, and
anything else you can think of with your webcam.
Just start it up and shoot! Gather all of your friends
around, have some fun! When you're done, share
your photos and videos with 'em!”

After installing from the PCLinuxOS repo, Cheese is
in the Video section of the menu. When you start it
up, your camera may already be recognized and is
showing you a view of wherever the camera is
pointing. This is the main Cheese window (below
left).
You can take a single photo, a video or a burst
(series of photos) with this program. The icons at left
below the image screen let you choose which you
want. Since the photo icon was clicked, the button in
the center is what you would click on to take a
photo. If you choose video, the button will say ‘Start
Recording’’. If you want a burst, click the burst icon,
and the center button will now say ‘Take Multiple
Photos’.
The first thing you should do after you open the
program is go to Edit > Preferences. You can set
your
image
resolution and
image
properties
(brightness,
contrast,
saturation and
hue),
and
configure your
burst properties
 how many
photos you want
in your series,
and how long
the
program
should wait in
between shots.
You can take up to 100 photos in your burst, and
can set a delay of up to 100 seconds. When you
take a burst, the series will be shown at the bottom
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of the main window. I was practicing with the image
properties settings in my living room:

I made it too light! Fortunately, Edit > Preferences is
just a mouse click away.
There are only three menus in Cheese: Cheese, Edit
and Help. The “Cheese” menu has the majority of
the items, while the “Edit” menu just has a few.
In
the
“Cheese”
menu, you have the
check
boxes
for
Countdown
and
Flash. When you
want to take a
picture, you can do a
3second countdown
before the photo is
actually taken, and
when the photo is
being taken, Flash
makes your whole
screen turn grey for a
second or two.
In that menu are radio buttons for choosing whether
you want a single photo, video or burst (or you can
choose from the buttons in the main screen). You
can also choose whether you want the program to
be visible in full screen, or just wide mode.
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Preferences is in the
“Edit” menu so you
can configure your
program. Notice that
you have the two
choices “Move to
Trash” and “Move All to Trash.” When you have
taken a photo or a burst, these won’t be greyed out.
You can choose a photo you don’t want and click
‘Move to Trash’, or just select “Move All to Trash”
and the program will delete them all.

want enabled. You see below a webcam photo with
the effect “Shagadelic” enabled.

Also in the “Edit” menu is another box to select or
deselect the effects screen:

When this program is installed, a folder called
Webcam will be created in your /home. Any photos
or video you take will be saved here.
You can have loads of fun with Cheese!

The effects are shown above. This screen shows up
when you choose effects from the menu or click on
the effects button towards the bottom right of the
screen. You can choose one or multiple effects
simply by clicking on them. Clicking the effects
button again takes you back to your visible image in
the main screen with the effects applied. That way
you can see how each effect looks, but you don’t
have to take multiple photos to see them. Take your
photo, video or burst when you have the effect you
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Available in the following desktops:
KDE

LXDE

Openbox

Xfce

Gnome

Enlightenment e17
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Gnome 2.32: Two Optical Burners
by Darrel Johnston (djohnston)
GnomeBaker
Described as GnomeBaker CD/DVD Writer in the
menu, it can be found in the Archiving section. It is
usually the default optical disc burning application
for a Gnome desktop. The project page shows
version 0.6.4 as being the current one, last updated
on June 9th, 2011. This is the version in the
PCLinuxOS repositories.

Under the General tab, you can choose a temporary
directory to use, and whether or not to clean the
directory upon exit of the program. You can also
choose to be notified when burning has completed,
and whether to display a progress bar or not.

Selecting the Advanced tab shows that the default
backend used for burning is wodim. I did not attempt
to add any other backends. You can also opt to
force recording and ignore directories too deep
warnings. I do not know if the latter option will
overcome some of the
limitations of the
genisoimage CLI program.

After starting the application, you will see the default
window shown below.

Selecting the Devices tab shows the system’s
optical devices, and whether they are writable or
not. I found that you can manually check and
uncheck the Write CDR, Write CDRW, Write DVD
R and Write DVDRAM boxes, but it makes no
difference to the actual operability of the program or
the optical device being used. You can click the
Scan for devices button, and all appropriate write
options for a given device will be automatically
checked.

The Edit pull down menu has only one option,
Preferences. It is here that you set the default
settings you want when you open the program.
These settings can be changed while performing an
operation. But, the program defaults won’t be
changed unless done from the Preferences window.
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You
can
manually
add a device
to the list
and always
scan
for
devices
at
program
startup.

Selecting the Tools dropdown menu from the
program’s main window shows all of the burning
options.
The
Window
dropdown
menu is shown below. Note
that if Show File Browser is
not selected, you won’t see
the Places and Name
sections in the program’s
main window.

Page 55

Gnome 2.32: Two Optical Burners
Brasero

I chose to erase the contents of a
rewritable CD. 4X was chosen by

default, which was the speed the disc was last
written at.
Selecting the Speed pulldown menu shows all
possible speeds available on the burning device
(above left).
The window below shows the CD being erased.
After the operation completed, I was given a
message to respond to and then returned to the
main program window.

From the main window, I next clicked the Data CD
button. In the Contents section, doubleclick
“GnomeBaker data disk” and enter a new name to
change the volume label of the CD or DVD. I
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Described as Brasero Disc Burner in the menu, it
can also be found in the Archiving section.
According to the project page, the latest stable
version is 3.0.0, dated April 5th, 2011. But, browsing
the
archive
at
ftp://ftp.gnome.org/pub/GNOME/sources/brasero/,
we see that the latest version in the directory tree is
3.4.1, released on April 16th, 2012. The version in
the PCLinuxOS repositories is 2.32.1. Shown below
is the main window that is displayed when the
program is launched.

changed it to “TestRun”. You can simply drag and
drop files and folders from the file browser section to
the contents section to have them included. Used
and remaining space is displayed. Once your
selections are complete, click the Burn button.
You can elect to write the contents to an image file
instead of an optical disc. For some reason, the
previously entered volume name is not carried over
to an image file
as it is to a disc.
So, change the
name of the
image’s iso file
in
the
next
window
from
“gnomebaker.is
o” to whatever
is desired.

The functions contained within the program are
handled by plugins. The plugins window is shown
below. Notice that one of the plugins is grayed out,
or “ghosted”.

I have found
GnomeBaker to
be
feature
complete.
It
may not have
all the bells and whistles of K3B, but it is adequate
for almost any optical burning task.
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In fact, only the first four plugins listed can be
selected in order to activate or deactivate it or
configure the options for that plugin. Reading the
package’s document file at /usr/share/doc/brasero
2.32.1/README, we see this:
Notes on plugins for advanced users
1. configuration
From the UI you can only configure (choose to use
or not to use mostly) non essential plugins; that is all
those that don't burn, blank, or image.
If you really want to choose which of the latters you
want brasero to use, one simple solution is to
remove the offending plugin from brasero plugin
directory ("install_path"/lib/brasero/plugins/) if you're
sure that you won't want to use it.
You can also set priorities between plugins. They all
have a hardcoded priority that can be overridden
through Gconf. Each plugin has a key in
"/apps/brasero/config/priority".
If you set this key to 1 this turns off the plugin. If you
set this key to 0 this leaves the internal hardcoded
priority  the default that basically lets brasero decide
what's best.
If you set this key to more than 0 then that priority
will become the one of the plugin  the higher, the
more it has chance to be picked up.
2. additional note
Some plugins have overlapping functionalities (i.e.
libburn/wodim/cdrecord/growisofs,
mkisofs/libisofs/genisoimage); but they don't always
do the same things or sometimes they don't do it in
the same way. Some plugins have a "speciality"
where they are the best. That's why it's usually good
to have them all around
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As examples, from my experience:
 growisofs is good at handling DVD+RW and DVD
RW restricted overwrite

that “vcdimager” could not be found in the path. Yet,
the file libbraserovcdimager.so exists in the
/usr/lib/brasero/plugins/ directory.

 cdrdao is best for on the fly CD copying

Even more puzzling are these three plugins, not
enabled:

 libburn returns a progress when it blanks/formats

cdrecord  burns, blanks and formats CDs and DVDs

That is a very imprecise way to handle program
functions to me. The best way to handle program
plugins would be to include a plugin manager that
either enables or disables them. The installation
path for the plugins is /usr/lib/brasero/plugins/.
Asking a user to remove unwanted plugins by
deleting files in the system area is asking too much.
Suppose the user decides s/he wants that function
later on? Reinstall the program?

mkisofs  creates disc images from a selection of
files

While browsing the plugin list, I noticed many items
did not show a check mark as being enabled. The
first was cdrdao, used for copying, burning and
blanking CDs. That function should be enabled by
default. I opened Synaptic, installed the cdrdao
package and restarted Brasero. The cdrdao plugin
was then enabled, but still grayed out. The
dvdauthor plugin was disabled, which is used for
creating disc images suitable for video DVDs.
Installing the dvdauthor package from Synaptic
enabled the plugin. The libdvdcss2 package was
also installed to enable the dvdcss plugin. That one
is understandable, as the package is considered to
be illegal in some countries.
Going further, the dvdrwformat plugin was
disabled. Installing the dvd+rwtools package
enabled it. The transcode2vob plugin shows that
“mplex” GStreamer plugin could not be found. In an
attempt to enable the plugin, I installed the
gstreamer0.10a52dec
and
gstreamer0.10dv
packages, but to no avail. The transcode2vob plugin
is inoperable, although the /usr/lib/brasero/plugins/
directory contains both libbraserotranscode.so and
libbraserovob.so files. The vcdimager plugin states

readcd  copies any optical disc to a disk image
Not only should all three of those plugins be enabled
by default, each one is listed as a symbolic link
pointing to another program. Well, the binary
executable programs all exist in the /usr/bin
directory, named cdrecord, mkisofs and readcd, the
exact same names as the plugins. Not only that, the
files libbraserocdrecord.so, libbraseromkisofs.so
and
libbraseroreadcd.so
exist
in
the
/usr/lib/brasero/plugins/ directory. If anything, those
plugins should have double functionality, not none at
all.
In searching the internet for information on the
Brasero plugins, I found quite a few user posts
echoing the lack of usability, some as late as May of
last year. I suspect that having a newer version of
the program in our repositories would not add much
functionality, if any at all.
Of the plugins that are enabled by default, and not
ghosted, Normalization should not be on by default.
Imagine that you are creating an audio disc with a
recording of Ravel’s Bolero on it. The exceedingly
soft passages at the beginning would be enhanced
and made louder. The thundering crescendos at the
end would be watered down in volume. You’d be left
with a recording that would not display the extreme
dynamic range of volume in the concert that Ravel
originally intended. For me, that would be extremely
disappointing.
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It is my opinion that the program should be
completely revamped. A working plugin manager
should be used to handle the program’s functions.
That, or package it with dependencies on the
backend binaries to be used, and include softlinks to
any external binary executables needed. There’s no
need to reinvent the wheel. Just make one that rolls
efficiently. Brasero’s usability and functionality
cannot hold a candle to GnomeBaker’s.

The place where breaking news,
BitTorrent and copyright collide

Screenshot
Screenshot Showcase
Showcase

Posted by Dragynn.
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Gnome 2.32: Tips, Tricks & Tweaks
by Paul Arnote (parnote)
Just as with any major desktop environment
available for Linux, there will always be tasks and
settings that are not the easiest to accomplish or
change – or even find. This couldn’t be any more
true than it is with Gnome, since the Gnome
developers have this mindset that obscurity is a
good thing. Never fear – they have taken that
obscurity to a whole new level with Gnome 3.x.

If your fonts are appearing rather skewed, it’s
actually quite easy to fix. First, right click your mouse
on an empty spot of your desktop window, and
select Change Desktop Background from the
context menu that appears.
Select the Fonts tab, then select the Details...
button.

Speed Enhancement: Icons
There are many that criticize Gnome as being a
heavy, resourcehog desktop environment. If you
are trying to run Gnome on an older and/or slower
computer, you can help improve performance by
changing your icon theme.

Some obscurity is a good thing, since you don’t
want all these settings and tasks to get in the way of
the user actually being able to use their computer.
But taken too far (as many, including Linus Torvalds,
claim the Gnome developers have done), excessive
obscurity prevents the end user from performing
many critical and necessary tasks. I hope that these
tips, tricks and tweaks help lift the veil of obscurity
from Gnome 2.32.

Avoid using SVG icon themes. SVG icons are re
rendered every time the icons are redrawn or
resized. Instead, use a PNG icon theme. If you find
a SVG icon theme that you just can’t live without,
convert the SVG icons to 128 x 128 PNG icons.

Deskew Your Fonts

Speed Enhancement: Nautilus

At the top of this new window, set the resolution.
Typically, a resolution of 96 dpi works for most
people. If you select a lower resolution – say, 72 dpi
– then your text will appear larger. If you select a
higher resolution – say 120 dpi – your text will
appear smaller. Adjust this value until your text
appears as you like. Don’t worry if you mess things
up. You can always return this value back to 96 dpi
(provided you can still read the screen!).
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While we’re talking about fonts, and while we’re
already in this window, you can also change
“Hinting” from “Full” to “Slight” to gain a slight speed
enhancement. I would not recommend turning
hinting off, since doing so may make your fonts look
fuzzy.

There is no denying that Nautilus is an excellent and
powerful file manager. It’s the favorite of many Linux
users, in part due to how configurable and
extensible it is. However, on slower and older
computers, Nautilus can slow to a crawl. All of those
extra “bells and whistles” can cause a performance
hit.
Luckily, we can turn off – or seriously trim back –
most of those bells and whistles, and in the process,
make Nautilus much more responsive on slower and
older computers.
From Nautilus’
Preferences.

menu

bar,

choose

Edit

>
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settings still result in sluggish performance from
Nautilus, you can set the values to even lower file
sizes. You can also set “Show thumbnails” to Never.
This will cause Nautilus to never show thumbnail
representations of previewable file types.

Speed Enhancement: Startup Applications
Select System > Preferences > Startup Applications,
and the window below will be displayed.

Third, under Sound Files, you can set “Preview
sound files” to Never. This prevents Nautilus from
playing back sound files when you hover your
mouse over the sound file icon.
Fourth, under Folders, you can change “Count
number of items” to Never. This prevents Nautilus
from displaying the number of files in the current
folder in its status bar.
Speed Enhancement: Metacity
Gnome 2.32 uses the Metacity window manager.
You can lessen the impact of Metacity themes on
the resources of an older or slower computer by
selecting Metacity themes that use simple colors.
Using themes that use images will slow down
rendering, causing a potential performance issue
with older or slower computers.
Click on the Preview tab. Once there, you can make
some changes that will help improve the
responsiveness of Nautilus.
First, under Text Files, set “Show text in icons” to
Never. This will prevent Nautilus from scanning the
text to show a preview of the text file when you
hover your mouse over the icon.
Second, under Other Previewable Files, set the
“Only for files smaller than” setting to something less
than 100 MB, which is the default in PCLinuxOS
Zen. I recommend setting this to either 10 MB or 5
MB. Files larger than the limit will no longer display a
thumbnail depiction of the file, and will revert to
displaying a generic icon associated with that
particular file type. If you find that these reduced
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While you’re at it, you can also turn off Metacity
animations. From a terminal session, enter the
following (all on one line):
gconftool2 type bool set
/apps/metacity/general/reduced_resources
true

Speed Enhancement: Gtk+ Themes & Wallpaper
Use Gtk+ themes that allow the user to change
colors. They are the simplest of all Gtk+ themes, and
thus consume the least amount of resources. For
wallpaper, use only wallpaper that uses “web safe”
colors, or solid colors. They are the ones that
consume the least amount of computer resources
when they are rendered.

There are quite a few applications that are started by
default in Gnome 2.32. However, there may be
applications that aren’t actually needed, and that
many people don’t use. Remove the check mark
next to those applications that you don’t need or
want to run when your computer starts up. Not only
will it help your Gnome session start faster, it will
also consume fewer precious resources on an older
or slower computer, since those applications won’t
be running in the background.
Also, so you can get to a working desktop faster,
you can select the “Options” tab and make sure that
the option to restart the applications from the
previous Gnome session are NOT automatically
started the next time you start up your computer.
Speed Enhancement: Compiz
Basically, turn it off. All of that eye candy comes with
a high price – a price that is exacted on your
computer’s resources. This includes processor
usage and memory usage. For some users, it boils
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down to whether to have a functional computer, or
one with flash and glitz. Personally, I choose
functional every time, over flash and glitz. The latter
is fine – if you have a computer that can handle it,
without having a noticeable effect on functionality.

wallpaper. Select the “OK” button to save your
settings and exit the dialog box.

Speed Enhancement: Replace Nautilus
While the added functionality of Nautilus is nice to
have, it does come at a price. Replace Nautilus with
PCManFM. You will save about 100 MB of memory
overhead by replacing Nautilus with PCManFM. The
choice of PCManFM is not only because it is a
lighter file manager, but also because once you get
rid of Nautilus, you will need something else to
manage the desktop – otherwise you won’t have any
way of managing the desktop. PCManFM has this
capability.
You don’t have to remove Nautilus from your
system. Just remove it as the default file manager
and desktop handler. First, enter the following in a
terminal session (all on one line):
gconftool2 type bool set
/apps/nautilus/preferences/show_desktop
false

Don’t panic. The above setting will probably mess
your desktop up (removing icons and wallpaper),
since you just removed Nautilus’s ability to manage
the desktop.
Second, install PCManFM from Synaptic. Once
installed, launch it, and select Edit > Preferences
from the PCManFM.
Click on the “Desktop” tab, then check the boxes
next to “Manage the desktop and show file icons,”
“Show menus provided by WM when desktop is
clicked” and “Wallpaper.” Select your wallpaper by
clicking on the far right side of the “button,” and
select the “Mode” to use when displaying your
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To make things easier, create a launcher on your
panel for PCManFM. Click on it whenever you have
work to do on files or you need a file manager.
Change Default Background Color
The default background color in Gnome is green.
This can be problematic if you are using a PNG file
with some transparent areas. Fortunately, this is
easy to change.
First, launch the gconfeditor from a terminal
session, by typing gconfeditor & at the command
line. This will launch the GUI version of gconfeditor.
Under PCLinuxOS, you do not have to be the root
user to use this utility.
Travel through the tree in the left pane to desktop >
gnome > background. Once you get there, you will
notice an appearance of the right pane that is a lot
like in the image below.

Note that the color designation (primary_color and
secondary_color) is a bit different than what you use
in Gimp or for the background color designation in a
web page. The first thing you will (should?) notice is
that the RGB color designation is twice as long as
you would normally expect. That is because the
typical color designation repeats for each color. So,
the #6666baba0000 green color designation
translates into #66ba00 in Gimp or HTML color
code.
Say you wanted to change the background color
from the default green to orange. Opening up Gimp,
we see that the color designation for orange is
#ffaa00, in hexidecimal. In gconfeditor, it becomes
#ffffaaaa0000. Notice how we double entered the
typical RGB values. Thus, the ff designation for the
red color channel in Gimp becomes ffff in gconf
editor. Similarly, the aa designation for the green
color channel in Gimp becomes the aaaa. The 00
designation for the blue color channel in Gimp
becomes 0000.
Clicking on any of the values in the right pane will
display a brief explanation of the expected values in
the lower right portion of the screen. Feel free to
experiment with the values. If you do, I recommend
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writing down the default values – just in case you
mess things up and want to return things to their
default values.
There are some transparent PNG wallpaper files in
the default installation of PCLinuxOS Zen. Changing
the background colors, as well as the
color_shading_type, will alter how the background
appears when you use them.
Of course, you can also control most of this by right
clicking on an empty spot on your Gnome desktop,
and selecting Change Desktop Background from the
context menu that appears.

about a low battery and a critically low battery. It will
also automatically take the assigned action (power
down, suspend or hibernate) when your battery
reaches the defined low level.
New Places – The Easy Way
One of the default menus in the standard Gnome
menu is the “Places” menu. When browsing around,
looking for ideas for the Gnome desktop article
series, I came across multiple users complaining
about how “difficult” it was to add new folders to the
“Places” menu.

Summary
I’m sure there are many more tips, tricks and
tweaks. I’ve tried to include the ones I thought would
be the most useful to the most number of people.
Particularly, the speed enhancement tips, when
applied, make Gnome as nimble and quick as the
lighter Xfce desktop. Gnome is a very robust
desktop environment, and it has a lot of fans,
despite the obscurity built into it by the Gnome
developers.

Clean Up Your Desktop
There are many users who don’t like to have a lot of
icons on their desktop. It reminds them too much of
Windows, where every application you install wants
to put its icon on your desktop.

Connect

Does your computer run slow?

Fortunately, with Gnome’s gconfeditor, it’s easy to
clean it up in a manner that is easily reversible at
any time. From a terminal session, type gconf
editor & at the command line. When the gconf
editor window appears, go to apps > nautilus >
desktop in the left pane. In the right pane, uncheck
the icons you wish to clear from your desktop. They
should disappear immediately.

Are you tired of all the "Blue Screens
of Death" computer crashes?
Are viruses,
adware, malware &
spyware slowing
you down?

Similarly, if you are a user who actually likes a
gazillion icons on your desktop, you can add any
that are listed by making sure the icons are checked.

Get your PC back
to good health
TODAY!

Gnome Power Manager
If you are running Gnome 2.32 on a notebook
computer, you will want to install the Gnome Power
Manager, since it’s not installed by default. With
Gnome Power Manager, you can keep close tabs on
the state of your battery. Gnome Power Manager will
also control when you receive warning messages
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All your
PCLinuxOS
connections in one
convenient location!

It’s actually much easier than these users were
making it out to be. To add items to your “Places”
menu, simply click and drag a folder from the right
pane of Nautilus to the bottom left pane in Nautilus.
Voila! There it is. You can organize them by
dragging them to their new position within the list.

Get

Download your copy today! FREE!
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Gnome 2.32: Resources
by Paul Arnote (parnote)
As the magazine closes out coverage of Gnome
2.32, I’d like to leave you with some additional
resources that you can call upon to further expand
your knowledge. As you can imagine, since the
announcement of Gnome 3.x, most of the remaining
Gnome 2.32 documentation is found at the sites of
other Linux distros.
Before long, much of the Gnome 2.32
documentation may become difficult to find. Thus,
you may want to print out any of the Gnome 2.32
documentation that you find for future reference.
Perhaps an even better idea would be to convert it
all to PDF files, rather than relying on a fragile paper
copy as your only source of reference.
Gnome 2.32 Desktop User Guide  this is a copy of
the official Gnome 2.32 user guide, from the Linux
Mint web site. If you want to know “typical user” stuff
about Gnome 2.32, this is the definitive resource.
Just in case you are unable to access the
aforementioned copy of the Gnome 2.32 Desktop
User Guide, you can also access a copy stored at
the Linux Mint web site.
Ubuntu Pocket Guide and Reference  if you stop
and think about it, this one makes sense. Ubuntu’s
“flagship” release is (was) built around Gnome.
Therefore, books that deal with Ubuntuproper will
obviously have to deal with Gnome.
Mate Wiki  just as there is the Trinity desktop fork
for KDE 3.5.x lovers, Gnome 2.32 loyalists have
forked Gnome 2.32. The project’s name is Mate. It’s
only natural to want to keep an eye on this page, as
well as the Mate home page. Since Mate is an
attempt to keep Gnome 2.32 breathing and with a
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heartbeat, the information should be applicable to
Gnome 2.32 – at least for a while. Since it only really
got off the ground in December, 2011, given a little
time, it should be quite the source for Gnome 2.3x
information.
Gnome Library  there is plenty of Gnome 2.x
documentation still available on the Gnome Library
site. This is one site with literally TONS of
information. The areas are divided into subsections
for users, administrators and developers. Steadily,
and unfortunately, Gnome 3.x data is starting to
supplant the Gnome 2.x information. I do hope that
someone has the foresight to archive the Gnome 2.x
information (Mate developers? Are you listening?)

Summary
I hope that you have found the magazine’s coverage
of Gnome 2.32 helpful. Since Gnome 3.x has a
special “fallback” mode, I thought it was important to
cover Gnome 2.32 before covering Gnome 3.x. Also,
Gnome 2.32 – or some resemblance of it – should
remain persistent for a while longer. Of course, no
one can tell the future of the Mate Desktop project,
and whether it will fail or succeed. One thing is for
certain: Gnome 2.32, and the Gnome 2.x releases
that preceded it, has left an indelible mark on Linux
history.

FreeBSD GNOME Project: Gnome 2.32  FreeBSD
has a good bit of support information for Gnome
2.32. Be selective with the information there. The
information is FreeBSDcentric, so some stuff will
apply, while other things won’t.
Mate Desktop  since the Mate Desktop is the
“official” effort to keep Gnome 2.3x alive, you may be
interested in keeping track of what is transpiring with
its continued development. You can also check out
the special Mate Desktop sections on the Ubuntu,
Linux Mint, and Arch Linux forums.
Linuxgator.org  finally, PCLinuxOS Gnome has its
own site and forum. This should be the first place
PCLinuxOS Gnome users go for assistance, since
the information is PCLinuxOScentric. Just as in the
main PCLinuxOS forum, the folks there are very nice
and friendly. In fact, you are likely to see a few
familiar faces haunting the forum there.

A magazine just isn't a magazine
without articles to fill the pages.
If you have article ideas, or if you
would like to contribute articles to the
PCLinuxOS Magazine,
send an email to:
pclinuxos.mag@gmail.com
We are interested in general articles
about Linux, and (of course), articles
specific to PCLinuxOS.
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